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Preface

This manual presentsinstallation and configuration information for NCD
NCBridge software and network computers. It iswritten for system and network
administrators responsible for installing network computersin a
distributed-computing environment. The procedures in this manual assume
familiarity with:

» The operating system and administration of the intended host computer.
» Thenetwork protocols and conceptsrelated to the local-areanetwork (LAN).
» The X environment, including window managers and display managers.

The following conventions and terminology are used in this manual.
» Pointing:  Using the mouse to position the pointer on an object on the

display.

» Moving: Using the mouse to change the location of the pointer on the
display.

» Clicking:  Pressing and releasing a mouse button without moving the
pointer.

» Dragging: Pressing and holding down a mouse button while moving the
pointer.

» Releasing: Releasing the mouse button to complete a dragging action.

Figure 1 on the next pageillustrates the typographical conventions used in this
manual.
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Definition or file name
Command
name

Bootstrap protocol, bootp] is the recommended way to exablish

to the Netstation in an internet protocol environment. ‘bootp obta
Command (type as is)
1. Verdy that the bootpd and bootprab files are in the /etc direct

Prompt (do not type) — . #[Is /ete/bootp* |
Variable (substitute 2. If they are not there:
the correct value)

~ :
# cp /tekxp/bin/<host=/bootpd /fete
3. Edit the Jetc/ho
1128.07.60.30 ] portland

Path

ile to add the Netstation internet address

Response on screen
or lines in a file

The parameters on the host computer must match the param

in order for serial communications to work. Your system ad

in the remote configuration file, or tell you what parameters 1

them in:S.
Program name — )

To verify or change your serial parameters:

1. PressiSetup.
Menu or key name
2, Select Setup.

s menu and release on

3. Drag on lhci-_(-: nﬁg

4. Determine if your cable is connected to Serial Port 0 or 1.

Menu button name
5. Select the Return to Main Menu: button.

Required variable —\

Required switch AulhorlzeT?aug_&(_{ff"a_{{(i!_r-ka_')_‘ |
(choose one) BMethod: ROM or MOF

Optional variable

Figure 1 Typographical Conventions
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Map to the NCBridge Documentation

Table 1 presents the contents of the manuals in the NCBridge Network
Computer Documentation set. These manuals are included on the

Documentation CD-ROM.

Table 1 Available NCBridge Documentation

Manual Title

Contents

NCBridge User Manual

Provides information on using the network computer
with NCBridge software.

NCBridge Reference Manual

Providesexplanation of all NCBridge, Setup Main Menu,
and Boot Monitor commands; plus Diagnostics, SNMP,
Tek220 and Tek340 Emulators, Printing, Keyboard,
CSLIP, and Scripting Language setup.

3270 User Manual

Provides information on using the OpenConnect 3270
emulator.

3270E/5250 User Manual

Provides information on using the TEEM X 3270E/5250
emulators.

and Configuration Manual

NCBridge for UNIX Installation

Providesinformation for installing NCBridge on aUNIX
server and explains how to configure the network
computer to download and execute the NCBridge
software.

NCBridge for VMS | nstallation
and Configuration Manual

Provides information for installing NCBridge on aVAX
VMS server and explains how to configure the network
computer to download and execute the NCBridge
software.

NCBridge for Windows NT
Installation and Configuration
Manual

(This manual) provides information for installing
NCBridge on a Microsoft Windows NT server and
explains how to configure the network computer to
download and execute the NCBridge software.

System or Network Administration manuals for your computer are also helpful
for looking up additional options, subnet masking, and broadcast addresses.

NCBridge for Windows NT Installation and Configuration Manual
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Discontinued Software Features

As NCD continues to add new features to make your NC hardware more
valuable, we are forced to discontinue support for some of the older software
features. Thefollowingisalist of featuresthat were supported in NCBridge 3.2
and earlier software releases, but are not supported in NCBridge 4.0.

Serial Xpress

Local OpenLook Window Manager

X Blink Extension

Local 3179G Terminal Emulator

Sun Audio Intercept Driver for Sun OS Environments
XIE

SIE

Display PostScript and Acrobat Reader

Flash Control Console Client

Support for XP10 X terminals

Serial Xpress

Serial Xpress enabled aNC or X terminal to connect to a remote host and
transmit X Windows data over an RS-232 cable, or indirectly over aphoneline
using modems. The NC can now be connected using PPP over an RS-232
connection, or connected to a DSL or ISDN connection using the standard
network port to provide remote access to a host replacing the need for Serial
Xpress.

Xii
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Discontinued Software Features

Local OpenLook Window Manager

Thelocal OpenLook window manager (OLWM) isawindow manager for the
X Window System that implements parts of the OPEN LOOK graphical user
interface, original developed by Sun Microsystems, Inc. This feature was
previoudy provided to allow the OLWM program to run asalocal client on the
Network Computer (NC) to help off load server resources. The OLWM window
manager is still supported on the NCs under X Windows by simply running
OLWM directly from a Sun host. OLWM is one of the standard window
managers on Sun’s Workstation products running Solaris. NCs still offer Local
Motif (MWM) or (XPWM) window managersto use in place of OLWM where
alocal window manager is necessary.

Local 3179G Terminal Emulator

Thelocal 3179G Terminal Emulation isno longer included. The local IBM
3179G Terminal Emulation included |BM 3720 support along with special IBM
Graphics functions (GDDM), including support for older IBM host graphics
applications. The NC still offers support for IBM 3270 Emulation.

NCBridge for Windows NT Installation and Configuration Manual xiii
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Pieces of the Puzzle

Xiv

Configuration isthe key to the successful integration of network computersinto
your environment. System configuration is represented as a puzzle: each piece
must be completed and integrated before the entire system configuration is
complete. The configuration puzzleisillustrated in Figure 2.

Throughout this manual, the individual puzzle pieces are used to visually guide
you through the system configuration process. Asyou compl ete each piece, you
are one step closer to acentralized system. When the puzzle is complete, you
have created a custom environment tailored to your computing resources, your
applications, and your users' requirements. As an added bonus, the system is
centrally administered, easy to maintain, and has the flexibility to adapt to your
changing computing needs.

Chapter 1, Installing the Software, isthefirst step in the configuration
process. This chapter describes how to load the network computer
software onto your computer.

Chapter 2, Making Choices, helps you analyze your environment and
select the best methods to configure your network computers and your
environment. Strategiesfor using acentralized configuration, integrating
additional network computers, and using Flash memory are also
included.

Chapter 3, Supporting a Centralized System, provides the host specific
procedures you need to implement your configuration decisions you
made in Chapter 2. Refer to Chapter 2 for information on which
procedures to perform.

Chapter 4, Local Clients, provides information about starting and using
the NCBridge local clients. Local clients execute on the network
computer instead of the host, thus reducing network traffic.

Chapter 5, Window Managers, provides information about the local
window managers; Motif Window Manager, and XpresswWare Window
Manager.

Chapter 6, Using Additional Fonts, describesthe procedures and utilities
necessary to make your fonts available to the network computer.

Chapter 7, Troubleshooting, describes debugging methods and solutions
to help troubleshoot your configuration.

NCBridge for Windows NT Installation and Configuration Manual
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Figure 2 The System Configuration Process
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Chapter 1

Installing the Software

— « &
IHHHHHHH . ‘ j

Thefirst step isto install the network computer software on one or more hosts.
The network computer plugs directly into the network, so you can install the

software on one host or distribute it across different hosts on the same network.

The mediacontainsall of the filesyou need to boot and configure your network
computers. With SETUP.EXE, you can install everything or select only thefiles
you need for your environment.

Note: You must be logged in as administrator to perform an
installation. Refer to your NT documentation for information
on setting up the administrator account to preservefile
permissions. The administrator should have read, write, and
execute privileges, but others only have read and execute.

This chapter providesaquick-start list. The chaptersthat follow present detailed
installation information.

NCBridge for Windows NT Installation and Configuration Manual



Chapter 1

Installing the Software

Quick Start

The following steps provide an overview describing how to install NCBridge
on the host and to configure an NC for operation. Details can be found in the

remainder of this manual. Also see the NCBridge Reference Manual for more
information.

NCBridge Installation

1. Log onto installation host.

2. Double-click on the My Computer icon on the desktop. Anicon representing
the CD-ROM should be present.

3. Insert the CD-ROM with the NCBridge software into the drive of the host.

4. The NCBridge installation wizard should begin to run. If not, select View >
Refresh and then double-click the NCBridge CD icon.

Follow the on-screen instructions for install ation.

NC Terminal Installation

1-2

1. Unpack the NC hardware and assemble it as described in the I nstallation
Guide provided.

2. Turn onthe NC.
3. When the boot screen appears, press the spacebar.

4. Set the following items:
I A <IP address of NC>
IH <IP address of boot host>
IM <subnet mask>
BP </destination_folder/tekxp/boot/0s.900>
| Gate <IP address of gateway host>
NVS (to save settingsin NVRAM)
B (to start boot process)

The network computer should boot for basic operation. Make custom changes
to the installation, as desired.

NCBridge for Windows NT Installation and Configuration Manual



Media Contents

Media Contents

The directory hierarchy is created relative to the destination folder. If the
destination folder C:\NCBridge was selected at installation time, al files and
foldersare installed in that location. The tekxp directory is also created under
the destination folder.

Throughout the NCBridge manuals, theinstall directory is assumed to be tekxp.
Here are the tekxp directories:

tekxp\bin\nt contains network computer utilities for the NT environment.

tekxp\boot contains boot files, fonts and clients. Files that differ between
models use a.model suffix. Refer to Table 1-1 for model information.

tekxp\boot\config contains the network computer configuration files.
tekxp\boot\fonts contains the supplied non-resident fonts.

tekxp\boot\<language_directory>\app-defaults contains translated text for
network computer clients.

tekxp\examples contains examples such as Xsession and bootptab.
tekxp\man\nt contains man pages for many of the included utilities.
tekxp\mgmt contains a sample SNMP MIB file.

NCBridge for Windows NT Installation and Configuration Manual 1-3
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1-4

Installing the Software

Running SETUP.EXE

These steps tell you how to perform a basic installation of the NCBridge
software on the Windows NT host. For details about customizing the software,
refer to the NCBridge Reference Manual, supplied on the Documentation
CD-ROM.

Getting Started

1.
2.

Log onto the NT host where you are going to install the NCBridge software.

Open the My Computer icon by double-clicking it. This displaysicons
representing system resources, including the CD-ROM.

. Insert the NCBridge CD-ROM into the drive. The CD-ROM deviceicon

should be replaced by the NCBridge icon (the drive label should say
NCBRIDGE_VERSION_ 4 0) and the installation wizard should begin. I
thisis not the case (and the NCBridge installation program does not start),
select View > Refresh and double-click the NCBridge icon.

. When the install programs executes, the NCBridge splash screen appears and

theinstall wizard software loads. A Welcome dial og appears. Click Next on the
on the Welcome diaog to proceed. Click Cancel at any time to abort the
installation.

Setting the Installation Path

When the installation process begins, the Choose Destination L ocation dialog
shown in Figure 1-1 appears. The Choose Destination Location dialog allows
you to set the desired installation path. By default thispathisC: \NCBridge
or the existing NCBridge instal | ation path. Clicking Browse brings up afile
selector, shown in Figure 1-2, to help you navigate though your file system for
a suitable destination location. Once the destination folder is set, click Next to
proceed. You can revisit previousinstall dialogs by clicking Back.

If you have a current install ation, your configuration files are saved for you. Be
sure to check the new configuration files for any new commands, and add any
applicable commands to your saved configuration files.

Note: If you change the destination folder for installation, ensure
the new path matches the Secure Read directory specified by
the NCD TFTP applet, displayed in the Control Panel.
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Setting the Installation Path

If thereisapreviousinstallation in the current directory, the configuration files
(.cnf and .tbl files) are preserved. The new configuration files are stored in the
directory <destination folder>\tekxp\config_date where date is the format
YMDHMS.

HCBridge Setup

Choose Destination Location
Select falder where Setup will ingtall files,

Setup will inztall MCEnidage in the following folders.
T Install ta this folder, click Mext.
ToInstall to a different folder, click Browse and select another folder.

ou can choose not ta inztall MCBridge by clicking Cancel ko exit Setup.

C:\MCBridge Browse... |

[rstallEhield

" Destination Folder

< Back Cancel |

Figure 1-1 Choose Destination Dialog

Chooze Folder (%]

Please choose the installation folder.

[

{21 Multimedia Files
{2 My Installations

..3# Recycled j

Ok I Cancel |

Figure 1-2 Selecting an Alternate Installation Location
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Chapter 1  Installing the Software

Next, the Font Server Query dialog shown in Figure 1-3 asksif you want to use
afont server.

NCBridge Setup

Font Server Query

b any ¥ Window client applications and environments require zpecial fonts nat included with
MCEBridge. Do you intend to usze a Font Server?

& ¥es | intend to use a Font Server

Mo, | will use the optional fonts provided,

Ital Eield

< Back | Hewt » I Cancel

Figure 1-3 Font Server Query Dialog

If you indicate that you want to use afont server, the Font Server Specification
dialog shown in Figure 1-4 appears.

1-6 NCBridge for Windows NT Installation and Configuration Manual



Setting the Installation Path

MNCEBridge Setup E3

Font Server Specification

Fleaze specify the addresz (IP ar name] of the Font Server and the aszociated port number
belove, MCBridge Setup will create an enty in the fontg kbl file with thiz information,

Address: Im

Fort: IF"1 oo

Ital Eield

< Back | Ment » I Cancel

Figure 1-4 Font Server Specification Dialog

Enter the |P address or hostname of the font server and the port number in this
dialog and click Next.

NCBridge for Windows NT Installation and Configuration Manual 1-7



Chapter 1  Installing the Software

Selecting Installation Options

In the Setup Type dialog shown in Figure 1-5 you can choose between three
software installation options:

» Full installs with all options. Recommended for most users.

» Compact quickly installs only those files necessary to boot and configure
NCD network computers. Theseincludethe network computer boot filesand
configuration files. Thisis good for upgrading existing NCBridge
installations.

» Custom alowsyou to choose specific packages for installation. Thisis
recommended for advanced users. Thisinstalls only the options you select.
By default, al options are pre-selected. To make your selection, click
Custom and click Next to access the Select Components dialog.

MNCEBridge Setup E3
Setup Type

Choogze the setup ype that best suite pour needs.

Click the type of Setup vou prefer.

Compact Install - Description
Cuztam Install Inztallz all MCEridge Metwark.
Computer zoftware. Reguires

approximately 114 MB aof dizk
Fpace.

Ital Eield

< Back | Ment » I Cancel

Figure 1-5 ISetup Type Dialog
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Selecting Installation Options

If you select the Custom install option, the Select Components dialog shown in
Figure 1-6 appears. A list of software components is shown with check boxes
indicating the desired selections. Some components are comprised of
subcomponents which can a so be custom configured. Highlight acomponent and
click Change to access subcomponent lists. If the Change button is disabled, then
the component you have highlighted does not contain a configurable
subcomponent list. After selecting the desired components for ingtallation, click
Next to begin the file transfer process.

MNCEBridge Setup E3

Select Components

Chooge the components Setup will install

Select the components you want to inztall, and clear the components pou do not want to
install

— Dezcription

Containg configuration files,
fonts, scripts, and rezource
file:z.

Canfiguration files
efault fonts

[ [w] Optional fants
[ Danizh
[ [v#] Finnizh
[ French
E
[+

H-[w] German

-] Italian

[+-[w) F.atakana LI
Space Required on D 116332 K
Space Available on D 16347240 K.

Ital Eield
< Back | Ment » I Cancel

Figure 1-6 Select Components Dialog
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Chapter 1  Installing the Software

If you select Compact Install or Full Install, the next dial og that appears|etsyou
verify your installation settings before the installation begins. The Start
Copying Files dialog shown in Figure 1-7 displays the setup type, destination
directory, and font server settings. If the settings are not what you want, click

the Back button to return to the Select Components dialog so you can change
them.

MNCEBridge Setup

Start Copying Files

Review zettings before copping files.

Setup haz enough information to start copying the pragram files. [F you want o review or

change any settings, click Back. If you are zatizfied with the settings, click Mest to begin
copying files.

Current Settings:

Setup Tepe: ﬂ
Full

Destination Directary:
[T esthMCEridge

Font Server:
Font Server: 0.0.0.0
Fort Number; 7100

<]

Ital Eield

< Back

o

Figure 1-7 Start Copying Files Verification Dialog

If the settings are correct, click Next to start the transfer of NCBridge software
from the CD-ROM to the destination directory on the server.

Installation Dialog (during the File Transfers)

The screen displays three file system status bar meters and a dialog box with a
status bar. The status meters on the left indicate the transfer status of individual
files, installation completion status, and overall disk usage. The status bar in the
dialog window indicates the percentage of the installation completed.
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Installation Completion

Installation Completion

When installation finishes, the Setup Complete dialog shown in Figure 1-8
appears, stating that the installation of the NCBridge software is compl eted.

NCBridge Setup

Setup Complete

Setup has finizhed instaling MCBridge on your server.

W ires, | want to start the MCD TFTP Service!

Click Finizh to complete Setup.

¢ Baclt | Firizh I

Figure 1-8 Setup Complete Dialog

This dialog asksif you want to start the NCD TFTP service. For more
information about the TFTP boot method, see the Boot Methods topic on page
2-5. Click the checkbox to indicate whether you want or do not want the TFTP
service to start at this point, then click Finish to exit from the NCBridge
installation program.
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Chapter 1  Installing the Software

Removing or Modifying An NCBridge Installation

The Welcome dialog shown in Figure 1-9 provides a convenient way to add,
modify, or remove components of an existing NCBridge installation. To start
the process, click Start > Settings > Control Panel. Click the Add/Remove
Programsicon and select NCBridge from the list of installed programs. Y ou
may need to insert your NCBridge Installation CD in the CD-ROM drive.

Setup
Welcome

Modify, repair, or remove the program,

WWelcome to the NCEridge w4.0 Setup kMaintenance program. This progran lets pou modify the
current ingtallation. Click one of the options below,

= Modify

Select new program components to add or zelect cunently installed
components to remove.

" Repair
ﬁ Reinztall all program components installed by the previous zetup.

@ Remowe all inztalled components.

Ital Eield

Hewt » I Cancel

Figure 1-9 NCBridge Setup Maintenance Welcome Dialog

» Select Modify if you want to add components or remove currently installed
components. The samedial og used during the original installation, the Select
Components dialog (shown in Figure 1-6) appears. Indicate how you want to
modify the NCBridgeinstallation by clicking on the checkboxes to select or
deselect the components you want, then click the Next button and the
reinstallation process will proceed.

» Select Repair if you need to reinstall NCBridge.

» Select Remove to uninstall the NCBridge software.
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Getting Acquainted

This section describes adding the first network computer to your system. It
contains step-by-step procedures for performing a basic network computer
installation. Follow the instructionsin this section to become familiar with the
network computer’s network configuration parameters, Boot Monitor, and
Setup utility. In addition to learning about the network computer, the
procedures presented in this section lead you through the basic host
configuration procedures for supporting network computers.

Note: Ifyou arefamiliar with network computers, skip to Chapter 2,
Making Choices, for information on integrating network
computersinto your system.

Basic network computer installation requires these steps:
» Configuring host files to support the network computer.

» Collecting information about your environment which is needed to boot the
network computer.

» Using the Boot Monitor to enter network computer communication
parameters and establish a host connection.

» Logging in through a Telnet session from the Client Launcher.
» Using Setup to enter the network computer configuration parameters.

After the basic network computer installation is compl ete, the network
computer is able to:

* Locate the host on the network.
» Download the operating system, configuration, and font files.
» Apply configuration files residing on the host.

Note: NT systems use backslashes (\) in their file paths. The
network computer uses front slashesfor internal file paths.
When specifying path entriesfor the network computer, asin
xp.cnf, Setup and other local clients, use front slashes (/)
instead of the normal NT backslashes. NCBridge software
trand ates between these two types of slashesasit accessesthe
NT server.
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Basic Installation

In adistributed computer environment, host computers perform a variety of
functions. The boot_host sends the boot_file to the terminal, allowing it to
function as an X display. The font_host contains the files defining the
appearance of the various character fonts that can be displayed by the network
computer. The network computer needs access to this host frequently in the
course of auser session. The login_host is the host where the user’ slogin
account is found. The login host supplies alogin window to the network
computer, using some utility that provides login services.

Here is an example showing information about a sample environment:

Boot Host: Compaq Proliant running Windows NT
Boot Host Name: oregon IP Address:  128.07.60.01
Network Computer Model: N916

Network Computer Name: portland IP Address:  128.07.60.30
Netmask: 255.255.255.0

Gateway Address: 128.07.60.100

Broadcast Address: 128.07.60.255

Boot Method: tftp

If you are not familiar with the listed terms, consult your Windows NT System
and Network Administration manuals.

For the examples in this section, it is assumed you have loaded NFS on your
Windows NT system, and have enabled a mount point to the network computer
information. Refer to your NFS manual for more information.

Note: NT systems use backslashes (\) in their file paths. The
network computer uses forward slashes (/) for internal file
paths. When specifying path entries for the network
computer, asin xp.cnf, Setup and other local clients, use
forward slashes instead of the normal NT backsashes.
NCBridge software trandates between these two types of
slashes asit accessesthe NT server.
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Network Computer Worksheet

Complete this worksheet prior to powering on the network computer. When
completed, theinformation on thisworksheet assistsyou in booting the network
computer and performing other procedures.

1.

. Network computer hardware address:

. Network computer name:
. Network computer |P address: . .
. Boot Path: boot_directory

Network computer model: NC
Find thisinformation on the network computer’s serial number tag.

Find thisinformation on the network computer’ sserlal number tag on the underside
of the base unit.

(/<boot_directory>/boot/<boot file> For example, /tekxp/boot/0s.900)

Use Table 1-1 to determine your boot file.
Table 1-1 Boot Files

Boot File Supported Network Computer Series

0s.330 XP100D, XP330 Series (example: XP338)

0s.350 XP100 Series, XP200 Series, XP350 Series, and X P400
Series (examples: XP117C, XP219, XP358)

0s.500 NC200 and NC400 Series (example: NC200H, NC215)

0s-1r.500 NC200 with Token Ring Option (example: N200TR)

0s.900 NC900 Series (example: N916)

6. Boot Method: tftp

7.

. Gateway on the network computer’ s subnet:

Subnet mask: . . ip_subnet_mask

Valid values are: (Class A) 255 0.0.0, (Class B) 255.255.0.0,
or (Class C) 255.255.255.0.

. Boot Host:

a. Host name:
b. Host | P address: | P address:
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Configuring Host Files

This example shows how to configure the nfs (Network File Service) host
utility to provide booting service.

Enabling NFS Access

In this example, NFSis used to download the network computer operating
system, X server, configuration files, and resident fonts.

1.

Add the boot_directory (/tekxp/boot) to be exported on the host. Export as
read only. Refer to your NFS documentation for information on the name
and location of the exportsfile.

. Edit the

\%SYSTEMDRIVE%%SYSTEMROOT%\system32\drivers\etc\hostsfileand
add the network computer name and address.

128.07.60.30 portland

. To enablethe mount point immediately, openthe NFS > NFS Server diaog.

Click on Exports. Usethe Add button to add and verify mount points.

. Open Main > Servicesto verify NFSisrunning.
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Powering on the Network Computer

Verify the physical installation of the network computer’ s cables, power cords,
keyboard, mouse, and network connection with the pictorial installation sheet
included in the packing box.

Turn on the network computer’ s power switch. On the first power-up, you must
specify the keyboard you are using. The North American 101/102 or VT200 is
selected by default (depending on the connected keyboard). Press Enter or
Return to accept thiskeyboard. For adifferent keyboard or nationality, pressthe
Spacebar to scroll through the list of available keyboards and press Enter or
Return to select the appropriate one.

After specifying the keyboard, press the Enter or Return key again to display
the BoOT> prompt.

The BooT> prompt indicates that you are in the Boot Monitor. The Boot
Monitor is asimple, command-line utility that provides an easy way to input
boot commands. These boot commands set the parameters which describe the
network computer in your network environment.

The scoreboard is an areain the upper right-hand corner of the boot screen. At
thistime, the scoreboard shows only default values. Use the scoreboard to
verify the entries you make in the steps that follow.
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Booting the Network Computer

To enter aboot command, type the command and its associ ated parameter after
the BooT> prompt. To complete an entry, press Enter. To see alist of the Boot
Monitor commands, type help and press Enter.

Note: An “unrecognized command” error message and description
appears on the screen if an invalid command is entered.

Theline numbersin the stepsrefer to lines on the network computer Worksheet
(page 1-15) where you filled in the appropriate information. If you have not
completed the Worksheet, do so now.

Using the Boot Monitor, perform the following steps:

1.

Usethe iaddr command to enter the network computer’s | P address. (See
Line4.)

BOOT> iaddr ip_address

. Use the bpath command to enter the boot path. (SeeLine 5.)

BOOT> bpath /<boot_directory>/boot/os.< model>

. Usethe imask command to enter the subnet mask. (SeeLine7.)

BOOT> imask ip_subnet_mask

. Usethe ihost command to enter the boot host’s | P address. (See Line 8b.)

BOOT> ihost ip_address

. Usethe igate command to enter the |P address for a gateway host if the

network computer is booting through a gateway. (SeeLine 9.)
BOOT> igateip_address

. Usethe bmethod command to specify TFTP as the boot method.

BOOT> bmethod tftp

Note: Check the scoreboard to verify your entries. If thereisan
error, re-enter the command using the correct value.
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Use the nvsave command to save the values in nonvolatile memory.
BOOT> nvsave

Use the boot command to initiate the boot process.

BOOT> boot

If the network computer |ocates the host and boot files, abar appears on the boot
screen showing the percent of download compl ete. Once the network computer
downloads all of the files required, a gray screen with an X-shaped cursor
appears. If the boot process fails without error messages, you probably entered
an incorrect parameter. Enter the appropriate command and parameter to
correct the error. After correcting the error, execute the nvsave and boot
commands. If booting fails again, refer to Chapter 7, Troubleshooting.

The HostMenu client appears. The HostMenu is designed to allow the user to
connect to different types of login hosts, such as Unix or Windows NT.

If you want to use xdm to connect to a Unix host, click on the XDM CP button.
The NC will broadcast an XDMCP message to al hosts. The hoststhat respond
to the broadcast message will be listed in the HostMenu. (See Figure 1-10.)

If you want to connect to aWindows NT host running Terminal Server Edition
with Citrix MetaFrame, click on the WinDD button. This displays alist of
Windows NT servers running Citrix MetaFrame software. Selecting one of
these hosts will display the local WinDD ICA client with alogin window.

NCBridge for Windows NT Installation and Configuration Manual

1-19



Chapter 1  Installing the Software

Figure 1-10 HostMenu Example
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Starting a Session with Launcher

Launcher

i

Client Launcher is used to start local clients by selecting a client from a menu.
An arrow to the right of a Client Launcher entry indicates a submenu that
contains additional local clients. As shown in Figure 1-11, selecting Host
Connections displays a submenu listing available connections, such as Telnet
or theWinDD ICA Client.

Console
Lock Screen
Hostienu

Host Connections -
Window Managers -
Multimedia P
QuUIT

Figure 1-11 Example Client Launcher
Press the SHIFT-Pause key to bring up the Client Launcher. The symbol in
the left margin indicates a Launcher menu selection. If the Launcher is not
present, press the SHIFT-Pause key or key sequence for your keyboard.

Table 1-2 Key Sequences for Displaying the Client Launcher

Keyboard Type Press

101/102 with Setup Setup key

Windows 95 or SHIFT-Pause

101/102 with Pause

Sun keyboard ALT-GRAPH-HELP

3270 keyboard Right ALT-ExSel (The left ALT key does not work.)
LK401 F3 key

Unix keyboard Alt-Graph
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Y ou can customize the Launcher client for your users through the
system.launcher file. Refer to the Using the Client Launcher section in
Chapter 4, Local Clients.

Opening a Telnet Session

Telnet provides a direct connection from the network computer to a host
computer. When Telnet is running, the network computer acts as a standard
VT102 terminal.

To open aTelnet session from Launcher:

1. Position the pointer on the Host Connections option to display the submenu.
Select Telnet to open a Telnet window as Figure 1-12 shows.

Telnet>

Figure 1-12 Telnet Window Waiting for an Open Command

2. Usethe mouseto position the pointer in the Telnet window. Type h and press
Enter to see alist of Telnet commands.
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3. Type:
Telnet> open hostname

where hostname is the name or network address of the host as Figure 1-13
shows.

Telnet> open oregon

Figure 1-13 Telnet Open Command

Once a connection is made you can log in as Figure 1-14 shows.

Trying. ..
Connected to 128.07.60.01.
Escape character is ‘"]~

login:

Figure 1-14 Telnet Window with a Host Connection

4. At thelogin: prompt, enter your user name:
login: user_name

5. When the password: prompt appears, enter your password:
password: password

Now that you are connected to the host, type the command and its associated
parameter after the # prompt. To terminate an entry, press Enter.
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6. Set the display environment variable for the network computer by entering
the following using the network computer’s IP address:

# setenv DISPLAY <ip_address>

7. If you run awindow manager, type your normal command line. In this
example, we are starting the Motif Window Manager.

# mwm &
If your window manager is available, your host environment appears.

Closing a Telnet Window

To close the Telnet window from the Telnet> prompt, type quit and press
Enter. When you are ready to conclude the Telnet session, log off your host:

# exit
then enter quit to close the Telnet window:

Telnet> quit
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Using Setup

Setup isa utility where you can add, modify, display, and save network
parameters. Parameters can be saved in NVRAM, or written to afile.

The Setup main menu isillustrated in Figure 1-15. The Setup main menu is
made up of four different areas: Menu Bar, Menu Input, Function Bar, and

Message Box.

Menu
Bar

Menu
Input
Area

Function
Bar

Message
Box

Figure 1-15 The Setup Main Menu
Note: The Setup window on your network computer may |ook

different from this example based on your network computer
model.
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To connect to a Unix host, use the following procedures to enter configuration
parameters using Setup. After each typed entry, press Enter.

1. Drag in the Configuration Summaries menu and release on TCP/IP.
- Enter the following:

Network Computer Name  network_computer _name
Default Telnet Host host_ name
Name Server 1 ip_address of name server

- Click on Return to Main Menu.

2. Drag in the Configuration Summaries menu and release on
X Environment.

- Select thefollowing:
Host Connect Method HostMenu

- Click on Return to Main Menu.

3. Drag in the Network Tables and Utilities menu and release on NFS Mount.
Click on Add Table Entry.

- Add an entry for each directory exported in the /etc/exportsfile:
Note: Only four entries may be saved into NVRAM.

File System Name exported directory
Local Directory local_directory
Transfer Size read size for transferring files

- Click on Return to Main Menu.

4. Drag in the Configuration Summaries menu and release on
Host File Access.

- Select thefollowing:
Primary File Access NFS
Primary Mount Path local_directory (from previous step)

- Click on Return to Main Menu.
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5. Drag inthe Network Tables and Utilities menu and release on Internet Host.
Click on Add Table Entry.

- Add your boot host and login host as follows:

Host IP Address ip_address
Host Name host_name

- Click on Return to Main Menu.
6. Click on Save Current Settings to store the current settingsin NVRAM.

Exiting Setup
When you are ready to exit Setup, click the Exit Setup button.

This completes the basic network computer installation process. Continuein
Chapter 2, Making Choices, where you will develop a centralized
administration scheme for a complete network computer install ation.
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Making Choices

This chapter helps you collect and organize the information you need to create
a centralized system, tailored to your environment. A configuration workbook
isprovided on page 2-21 to assist you in this process.

If used as intended, the Workbook provides a valuable record for future
reference. Thetimeyou spend gathering information asyou plan and set up your
network computers may well save you hourslater in case it becomes necessary
to debug a configuration later in the installation process.
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Planning Configurations

We suggest the following procedures to help you use of the content in this
chapter profitably:

Make a copy of the Workbook (page 2-21 to the end of this chapter). To
make it easier to plan and set up your configuration choices, the Workbook
follows the same organization as the remote configuration file (xp.cnf).

Read through the strategy sections beginning on page 2-3. The strategy
sections are organized to help you analyze your environment and lead you
through the decision-making process.

Asyou make configuration choices, place a check mark on the Workbook
line as directed, then fill in the requested information. Some linesin the
Workbook direct you to other Workbook lines. Place a check mark on the
new line and fill in theinformation. Whenever possible, entries have been
filled in for you.

After you complete a Workbook line, return to the strategy text where you
left off.

When the Workbook is complete, continue in Chapter 3, Supporting a
Centralized Systemfor your host type. Edit thefiles as needed to incorporate
your configuration choices from the completed Workbook. When you edit a
line in the xp.cnf file, it matches the line in your Workbook.
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Configuration Strategies

System configuration is the key to successfully integrate network computers
into your environment. With proper configuration, you can ensure your users a
smooth transition to network computers with little or no disruption of their
work.

Network computers run efficiently in a distributed-computing environment,
where processing is shared by a number of networked host computers. This
means appli cations competing for resources at any given time can be distributed
across the system to maximize performance. Files can also be stored and
transferred among the accessible computers to share mass storage resources.

The network computer typically connects directly to the network, so it can
effectively communicate with any host on the network. The network computer
receives files and displays information over the network and manages
communications between processes running on the network computer and on
the host.

In adistributed computer environment, host computers perform a variety of
functions. The strategy sectionsrefer to three types of hosts, athough in reality
the functions can be as distributed or consolidated as you choose.

A boot host contains the files necessary to boot the network computers. This
includes the model-specific operating system files and xp.cnf file. These files
are downloaded to the network computer via the specified boot method.

A file host contains additional configuration files, fonts, and optional
host-specific utilities for the network computer. The network computer may
frequently access this host during a user session. Files are downloaded to the
network computer via the specified file access method.

A login host isthe host where the user’ slogin account isfound. Y ou can specify
a host for each user, or alow the user to select from alist of hosts, depending

on your host connection method. The login host supplies alogin window to the
network computer, using a utility that provides login services.
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The strategy sections discuss the basics required to configure and support a
centralized system. To simplify thistask, all of the network computer features
are not covered. Once your initial configuration is working, you can enable
additional features as needed.

Note: When you add a feature, perform the necessary host
configuration to support thefeature. Refer to Chapter 2 of the
NCBridge Reference Manual for more information.

These topics are discussed:
» Booting Strategies
- Boot Methods
- Automatic or Manual First Boot
- Subsequent Boots
» File Access Strategies
- File Access Methods
» Host Connection Strategies
* ROM and Flash Memory Strategies
» Boot Host Check List
* Network Computer Check List
» FileHost Check List
* What Next?
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Booting Strategies

On a system with many network computers, you might want to install the boot
software on more than one host. Then you can either set up different network
computers to boot and download files from different hosts, or set up all the
network computers to boot from the first available host.

Boot Methods

The network computer uses the boot method to download the X server. Many
of the other booting decisions in this section depend on the boot method you
select. The boot methods are TFTP, NFS, MOP, and ROM.

Notes: NT systemsonly support TFTP, NFS, or ROM booting.

NFSisnot supplied with NCBridge. It is available from third
party software vendors.

* TFTP (Trivia File Transfer Protocol) can be used on TCP/IP networks. Itis
not as efficient as NFS, but can be made more secure. TFTP isthe default
method to boot network computers not equipped with TDEnet or the Flash
Memory or ROM options.

Note: Duringinstallation and setup, adialog (shown in Figure 1-8)
asksif you want to start the NCD TFTP service. If you leave
the checkbox selected, TFTP starts; if you uncheck this box,
the TFTP instructionsin a Readme file appear. This
Readme.txt fileislocated in the tekxp/fm/nt directory.

* NFS (Network File Service) can be used to boot the NC from hosts
supporting NFS (typically in a TCP/IP network). The advantageto NFSis
faster booting and increased efficiency.

* ROM (Read-Only Memory) can be used with network computers equipped
with Flash Memory or aROM board. ROM isthe default method to boot al
network computers equipped with the Flash Memory or the ROM options.
Refer to ROM and Flash Memory Strategies on page 2-16 for more
information.

NCBridge for Windows NT Installation and Configuration Manual 2-5



Chapter 2 Making Choices

* MOP (Maintenance Operation Protocol) is used on DECnet networks to
download the boot files to the network computers. See the NCBridge VMS
Installation Manual for details.

Decide which boot method to use. Continue to the next pages to see how to
implement the method you selected.

Automatic or Manual First Boot

For afirst time boot, the network computers can boot automatically or
manually, depending on how you configure your environment. This decision
does not relate to ROM-based network computers.

Automatic means that the network computer determines boot parameters from
the network and boots without operator intervention. In addition, with
automatic booting you can implement a strategy where network computers can
boot from the first available host.

Manual means that an operator would have to enter the boot parameters before
the network computer could boot.

Implement the manual method if you areinstalling a single network computer.
Use the Boot Monitor to enter the boot parameters. Implement your other
Workbook selections with the Setup commands. Remember that Setup
commands only affect the individual network computer.

Implement the automatic method if you are installing or planning to install
more than one network computer, or want the network computers to boot from
the first available host. Implement your other Workbook sel ections with the
xp.cnf commands so they apply to each network computer.

For automatic booting:

If you are going to use TFTP or NFS as the boot method:

Check Workbook line 55 to use bootp (BOOTSstrap Protocol) or check
Workbook line 56 to use DHCP for automatic booting. A host that
recognizes the network computer’s hardware address responds with the
following information: the network computer’s Internet address, the boot
server’s Internet address, the name of the file to download, the subnet mask,
and the primary gateway.
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Subsequent Boots

The next boot decision determines how subsequent bootsoccur. There arethree
main strategies:

» Booting from a specific host, using parameters stored in NVRAM:

- Controlswhich host is used. In the case of different workgroups on
different hosts, each workgroup can have their own configuration.

- Provides an easy way to create a fixed environment.
- Provides a specific backup (secondary) boot.

» Booting from the first available host, using parameters obtained from the
network:

- Theleast-busy host responds to the boot requests.

- Provides backup booting. Booting occurs as long as any host is
responding.
» Booting from a specific host, using parameters obtained from the network:

- Controlswhich host is used. In the case of different workgroups on
different hosts, each workgroup can have its own configuration.

- Easier to administer in a dynamic environment, where network
computers, workgroups, and network addresses tend to migrate.

- Easier to provide a consistent environment.

Decide which strategy to use. Continue to the next page to see how to
implement the strategy you selected.

Note: NT systems only support TFTP or NFS booting.
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Booting from a specific host, using parameters stored in NVRAM:

For this method, specify all of the required information, change booting to
NVRAM, and saveit. Y ou can specify a secondary boot in case the primary
boot fails.

The network computer has already booted once. If the current boot parameters
are acceptable, do not change the primary boot information. The network
computer saves the current method, host, and path as the primary.

To change the primary booting information:

Choose the primary boot method to use, either TFTP or NFS:
For TFTP, check Workbook line 26.
For NFS, check Workbook line 27.

Check Workbook line 34 to boot from NVRAM instead of NETWORK.
Check Workbook line 39 to save the new method.

To optionally set secondary booting information:

Choose the secondary boot method to use, either TFTP or NFS:
For TFTP, check Workbook line 28.
For NFS, check Workbook line 29.

Booting from the first available host, using parameters obtained from the
network:

Set up automatic booting (from the previous section) on every boot host. Add
the information for every network computer to every boot host.

- You can explicitly set the boot method but obtain the remainder of the
boot parameters from the network. For example, if you want to boot with
NFSinstead of TFTP. To change the default boot method:

Choose the primary boot method to use, either TFTP or NFS:
For TFTP, check Workbook line 26. Ignore boot host and path settings.
For NFS, check Workbook line 27. Ignore boot path setting.

Check Workbook line 39 to save the new method.
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Booting from a specified host, using parameters obtained from the network:

Set up automatic booting (from the previous section) on every boot host. Add
the information for the specific network computer to the specific boot host.

- You can change only the boot method. Follow the preceding check mark
paragraphs for the booting from the first available host section.

File Access Strategies

File access determines how the network computer locates and downloads
configuration and font files. As discussed in the Configuration Strategies
section, you can have one or more file hosts.

Thefile access path you specify is actualy the path to the configuration (.tbl)
files. For fonts, the fonts.thl file contains the actual pathsto the files, not the
actual fonts. This may be confusing at first, but makes sense if you think about
it. Font files take up alot of disk space. By having the configuration file point
to the various locations, you can distribute fonts across disks, partitions, or
different hosts, depending on your disk space.

Here are some considerations for afile host:
» The host may be frequently accessed during a user session.

» Font filesuse alot of disk space, so make sure you only have the ones you
need. Many of the fonts on the installation media are probably duplicates of
your host computer’ s native fonts. If the X server can read your computer’s
native fonts, use them and only keep the unique fonts from the installation
media.

» Placethefiles on a machine with enough room. This does not have to bethe
boot host; the files can beinstalled in any directory on any machine on the
network accessible to the network computers.

» Theentriesin the fonts.thl file use network computer memory, so only add
the font directories your applications require.
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File Access Methods

Thefile access method choices are similar to the boot method choices. Thefile
access methods are: TFTP, NFS, and DAP. The method you select is
dependent on your network type and how your users connect.

Note: When afile_path isrequested, provide the path to the .tbl
files. The default path is /tekxp/boot/config. In most cases,
these entries are not required.

If you do not enable any file access hosts or methods, the boot host and boot
method are used by the network compulter.

NFS can be used on hosts supporting NFS (typically on a TCP/IP network).
The advantage to NFSis downloading speed and efficiency.

TFTP can be used on TCP/IP networks. It is not as efficient as NFS.

DAP isused on DECnet networks to download files to the network computers.
See the NCBridge VMS | nstallation Manual for details.

Select a primary file access method:
Check Workbook line 10 to use NFS as the primary file access method.
Check Workbook line 11 to use TFTP asthe primary file access method.

In addition, a secondary (backup) method can be enabled. The secondary
information is only used if the primary method fails.

Select a secondary file access method:
Check Workbook line 13 to use NFS as the secondary method.
Check Workbook line 14 to use TFTP as the secondary method.

Note: If the last method tried is NF S, the network computer
automatically triesTFTP using the last file path specified. To
take advantage of this feature, make sure TFTP is enabled.

Check Workbook line 53 to enable TFTP.
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Font Access Strategies

Using afont server.

The xfs font server is host-resident software that can perform all the tasks
related to downloading fonts to NC terminals. The font server can provide
access to morefontsthan basic font service does and it can decrease the time
it takesto display fonts. The font server reads both bitmap and outline font
formats.

Enter the desired font server on Workbook line 52.

Using font paths.

The NC supports reading of many font types. See Chapter 6, Using Fonts,
for details.

Enter desired font paths on Workbook line 52.

Host Connection Strategies

Host connection specifies how a user connectsto their login host. There are
several possibilities:

HostM enu presents alist of hosts. The user uses the mouse to select a
session type and login host (thisis the default method). Thisis easy to use
and provides flexibility for users who need access to multiple hosts.

Login Window to a Specific Host. Displays a host login box where the user
simply logs in to the host.

Session Window to a Specific Host. Opens a session window and connects
to the specific host. The user smply logsin.

Session Window with no Specified Host. Opens a session window. The
user would have to specify a host connection and then log in.

No connection method. The user would have to start a session from the
Client Launcher and then login.

Pick the method that best fits your users and your environment.
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HostMenu

HostMenu is the default connection method. Within the HostM enu interface,
there are multiple lists of hosts available: XDMCP, VM S (both TDEnet and
TCP/IP connections), TELNET, CTERM, LAT, IBM and WinDD. A user
can pick thelist to view, and then pick ahost from that list. Y ou can support as
many of the lists as apply to your environment.

XDMCP - thisisagenerated list based on hosts that respond to the network
computer’ s xdm broadcast. xdm must be enabled on the host. Responding
hosts can be optionally prioritized to appear at the top of the list.

Check Workbook line 58 to enable xdm on the host.
Check Workbook line 41 to optionally prioritize hosts on thelist.

VM STDERnet - thisisalist of entriesyou specify in the xp.cnf file. Usethis
list if you connect to DEC hosts running DECnet.

Check Workbook line 42 to add VM S TDEnet host entries.

VMSTCP/IP - thisisalist of entries you specify in the xp.cnf file. Use this
list if your users connect to DEC hosts running TCP/IP.

Check Workbook line 43 to add VM S TCP/IP host entries.

TELNET - thisisalist of entries you specify in the xp.cnf file. In addition,
the boot host and the default Telnet host (if defined) appears on the list. Use
thislist if your users connect to TCP/IP hosts via Telnet.

Check Workbook line 44 to add TELNET host entries.
Check Workbook line 36 to define adefault TELNET host.

CTERM - thisisalist of entries you specify in the xp.cnf file. In addition,
the boot host and the default CTERM host (if defined) appears on the list.
Usethislist if your users connect to DECnet hosts via CTERM.

Check Workbook line 45 to add CTERM host entries.

Check Workbook line 35 to define adefault CTERM host.
LAT - thisisagenerated list based on available LAT services.
Check Workbook line 9 to start LAT services on the host.
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* IBM -thisisalist of IBM host entries you specify in the xp.cnf file.
Check Workbook line 44 to add IBM host entries.

» WIinDD - thisisalist of Windows NT servers you specify in the xp.cnf file.
Check Workbook line 46 to add Windows NT server entries.

Login Window to a Specific Host

This option uses a utility on the specified host to display alogin box on the
network computer. The method you select for this option is network and host
connection dependent.

If your user logsin to a TCP/IP host on a TCP/IP network:
Check Workbook line 16 to specify a direct host connection.
Check Workbook line 58 to enable xdm on the host.

If your user logs in to a DECnet node in a DEC environment:
Check Workbook line 17 to specify a direct host connection.
Check Workbook line 63 to enable DECwindows on the host.

If your user logsin to a TCP/IP host in a DEC environment:
Check Workbook line 18 to specify adirect host connection.
Check Workbook line 58 to enable xdm on the host.

If your user logsin to aWindows NT server:

Check Workbook line 18 to specify a direct WinDD host connection.
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Session Window to a Specific Host

This option can be used to display either aTELNET or CTERM session
window on adefined host or node. The session you select for thisoption is host
dependent.

If your user logs in to a TCP/IP host, specify the connect method to be
TELNET, and define the default Telnet host:

Check Workbook line 19 to specify TELNET.
Check Workbook line 35 to define adefault Telnet host.

If your user logs in to a DECnet node, specify the connect method to be
CTERM, and define the default CTERM host:

Check Workbook line 20 to specify CTERM.
Check Workbook line 36 to define adefault CTERM host.

Session Window with No Specific Host

This option opens a session window. The user would have to open a host
connection or service. Several sessions are available: TELNET, CTERM,
LAT, SERIALO, and SERIAL 1. The session type you select is network and
host connection dependent.

If your user logsin to a TCP/IP host:

Check Workbook line 19 to specify a Telnet sesson.
If your user logs in to a DECnet node:

Check Workbook line 20 to specify a CTERM session.
If your user logsinto aLAT service:

Check Workbook line 21 to specify aLAT session.

If your user logs in viaa serial connection on their network computer serial
port O:

Check Workbook line 22 to specify a Serial O session.

If your user logs in via a serial connection on their network computer serial
port 1:

Check Workbook line 23 to specify a Serial 1 session.
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No Connection Method

Y ou can have the network computer simply display the root weave and X cursor
by disabling host connections. A user would have to start a session from the

Client Launcher.

To disable host connections:
Check Workbook line 25.
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ROM and Flash Memory Strategies

2-16

Reading Host-Based Remote Configuration Files

Network computers with Flash Memory can be set up to read an xp.cnf file on
the host. Another strategy if you have space in Flash Memory, isto flash a
version of xp.cnf to free the network computer from trying to find a host during
the boot process.

Check Workbook line 32 to read a host-based xp.cnf file with a network
computer equipped with Flash Memory.

Saving Your Configuration in Flash Memory

Asyou have worked through this chapter, you have selected the commands to
implement in the configuration file. For RAM-based network computers, this
configuration can either be saved in NVRAM, or loaded each time the network
computer boots and reads the xp.cnf file. To take advantage of the Flash
Memory option, you can flash all or part of your configuration.

This section provides the basic flash procedure. Refer to Chapter 2 of the
NCBridge Reference Manual for the specific flash commands.

» Create aremote configuration file with the do_flash and appropriate
flash_feature enabled. Change the boot_method to ROM (for subsequent
boots). If you are not going to flash the remote configuration file, you may
wish to set the network computer to read a host-based xp.cnf file.

» Boot only the network computers that you want to flash. Use TFTP or NFS
as the boot method. Y ou cannot flash a network computer that booted from
Flash Memory (boot method ROM).

» Once flashing is complete, comment out the flash information in the xp.cnf
file. Restore the boot_method settings as needed for your other network
computers.

Enabling a Master Network Computer

A network computer equipped with Flash memory can be used as a master
network computer to boot other network computers.

Check Workbook line 33 to enable or boot from amaster network computer.
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Boot Host Check List
Use this check list to verify that each boot host is completely configured:

Boot software installed.
ip_host_table and ip_host_entry commands added to the xp.cnf file.

Check Workbook line 1.

gateway_table and gateway_entry commands added to the xp.cnf fileif the
network computers are located on different subnets and require a gateway.
Check Workbook line 3.

Primary and Secondary (if used) boot method enabled.

xp.cnf file configured.

Supporting host processes enabled and running.

Note: The_table(ip_host_table) commands store up to four entries
in the network computer’s NVRAM. Use them for the most
frequently accessed hosts. The_entry (ip_host_entry)
commands store all subsequent entriesinto RAM.

File Host Check List
Use this check list to verify that each file host is completely configured:

Configuration and font files installed.
ip_host_table and ip_host_entry commands added to the xp.cnf file.
Check Workbook line 1.

gateway_table and gateway_entry commands added to the xp.cnf fileif the
network computers are located on different subnets and require a gateway.

Check Workbook line 3.
Primary and Secondary (if used) file access method enabled.

Font paths added to fonts.thl file.
Check Workbook line 52.
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Seriald Provides Remote COM Support for
Windows NT Applications

Serialdisalocal daemon that executes on the network computer. It providesthe
ability for aWindows NT application to transmit and receive datato and from
aperipheral device connected to aremote network computer serial port. Typical
peripheral devicesinclude printers, credit card readers, and PalmPilots.
Figure 2-1 shows how peripheral devices, Windows NT servers running NCD
ThinPATH Plus, and network computers running Seriald are connected.

Network
COM data j\
“
3
Network [
NT Server r nn'n(;ogs:‘l;eo: = N —— — 4| Peripheral
. unni i
running Serial cable —"F

ThinPATH Plus |

2-18

Figure 2-1 How Seriald Redirects Data to a Peripheral Device

Seriald interactswith the ThinPATH Plus software, which runsunder Windows
NT 4.0, Termina Server Edition (TSE). ThinPATH Plus adds support for
peripheral devices such aslocal printers.

For example, asan NT application transmits datato a standard COM port,
ThinPATH Plus intercepts the data and redirects it to the network computer
located on the network. Upon receiving the data, the Seriald daemon passesthe
data on to the network computer seria port where the peripheral deviceis
connected.

Seriald provides several benefits. For example, Seriald makesit possiblefor an
unmodified NT application to interact with a peripheral device connected to a
remote network computer serial port. Seriald also provides the ability to
synchronize the data on a PalmPilot with an application executing on an NT
server.
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By default, Seriald automatically starts when the network computer boots
(restarts). Y ou can use these two xp.cnf commands to control the Seriald
daemon:

start SERIALD NO # [YES | NOJ
preload SERIALD PERM # [NO | TEMP | PERM]

Refer to the NCBridge Reference Manual for details on how the xp.cnf
commands work.

Note: ThinPATH Plusalso supports redirection of audio and LPT
data from an NT application to either a PC or a ThinSTAR
Windows-based terminal; however, these features are not
supported on the network computer at thistime.

For more information about the ThinPATH Plus software, see the Network
Computing Devices, Inc. (NCD) website, www.ncd.com, under Products.
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Network Computer Check List
Gather the following information for each network computer:
* Network computer model (to determine boot path)
* Network computer hardware address
* Network computer name
* Network computer network address
This list shows the various host files that need network computer information:

* %SYSTEMDRIVE%%SYSTEMROOT%\system32\drivers\etc\hostsis
needed on all hosts the network computer accesses.

Check Workbook line 59.
* bootptab file, if bootp is used, is heeded on all boot hosts.
Check Workbook line 55.

What Next?

 Edit thexp.cnf fileand implement any commands you checked on Workbook
page 2-21 through page 2-36. Or, if the majority of your check marked lines
have a corresponding Setup menu item, you may wish to enter your
information in Setup and use the Save Settingsto Filefeature. Any remaining
check marked items could be added to the created file.

+ Edit any of the .tbl files you checked on Workbook page 2-35.

When you are done editing the configuration files, continue on to the chapter
Supporting a Centralized System for your host type.

» Perform the host procedures you checked on Workbook page 2-36.
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Configuration Workbook

. Enter one or more host address/names (NVRAM).

ip_host_table
ip_host_table
ip_host_table
ip_host_table

If you have additional hosts, fill out Workbook line 5.

. Enter one or more node address/names (NVRAM).

tde host table
tde host table
tde host table
tde host table

If you have additional nodes, fill out Workbook line 6.

. Enter one or more net address/gateway addresses (NVRAM).

gateway_ table
gateway_ table
gateway_ table
gateway_ table

If you have additional hosts, fill out Workbook line 7.

. Enter one or morefile system name/local directories (NVRAM)
along with the file transfer size (128 - 8192).

nfs_ table

xp.cnf File

nfs_ table

nfs_ table

nfs_ table

Fill out Workbook line 54. Also, if you have additional NFS
entries, fill out Workbook line 8.

Configuration Wor kbook

Setup Menu
Paths

Network Tables
and Utilities >
Internet Host

Network Tables
and Utilities >
TDEnet Host

Network Tables
and Utilities >
Gateway

Network Tables and

Utilities >
NFS Mount
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To
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. Enter one or more host address/names (RAM).

ip host entry

xp.cnf File

ip host entry

ip _host entry

ip host entry

Continue adding entries as needed.

. Enter one or more node address/names (RAM).

tde_host_entry
tde_host_entry
tde_host_entry
tde_host_entry

Continue adding entries as needed.

. Enter one or more net address/gateway addresses (RAM).

gateway entry

gateway entry

gateway entry

gateway entry

Continue adding entries as needed.

. Enter one or more file system name/local directories (RAM)
along with the file transfer size (128 - 8192).

nfs_entry

nfs_entry

nfs_entry

nfs_entry

Continue adding entries as needed.
Fill out Workbook line 54.
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xp.cnf File

9. Enter node name/LAT service tables (up to 20 services).

lat_services_table

lat_services_table

lat_services_table

Continue adding services up to 20.

10. Enter the file system name (for file_host_name) and the local
directory (for file_path).

file access_1 NFS

file host name_ 1

file path 1

Fill out Workbook line 4 and Workbook line 54.

11. Enter the host address or name and the file path.
file access_1 TFTP

file host name_ 1

file path 1

Fill out Workbook line 53.

12. Enter the node address or name and the file path.
file access 1 DAP

file host name_ 1

file path 1

Fill out Workbook line 60.

13. Enter the file system name (for file_host_name) and the local
directory (for file_path).

file access_2 NFS

file host name_ 2

file path 2

Fill out Workbook line 4 and Workbook line 54.

Configuration Wor kbook

Setup Menu
Paths

Not available

Configuration
Summaries>
Host File Access

Configuration
Summaries>
Host File Access

Configuration
Summaries>
Host File Access

Configuration
Summaries>
Host File Access
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To

2-24

xp.cnf File

14. Enter the host address or name and the file path.
file access_2 TFTP

file host name_ 2

file path 2

Fill out Workbook line 53.

15. Enter the node address or name and the file path.

file access 2 DAP

file host name_ 2

file path 2

Fill out Workbook line 60.

16. Enter the address or name of the XDM CP host.
host connect method XDMCP_ DIRECT
xdmcp connect DIRECT

xdmcp_server

Fill out Workbook line 58.

17. Enter the node address or name.
host connect method VMS
vms_autologin transport TDENET

vms_autologin tdenet host

Fill out Workbook line 63.

18. Enter the host address or name.
host connect method VMS
vms_autologin transport TCPIP

vms_autologin tcpip host

Fill out Workbook line 58.
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xp.cnf File

19. host connect method TELNET
Fill out Workbook line 19.

20.host _connect _method CTERM
Fill out Workbook line 20.

21. host connect method LAT
Fill out Workbook line 21.

22.host _connect _method SERIALO
Fill out Workbook line 22.

23.host _connect _method SERIAL1
Fill out Workbook line 23.

24. host _connect method WINDD
Fill out Workbook line 24.

25.host connect method DISABLED

Configuration Wor kbook

Setup Menu
Paths

Configuration
Summaries>
X Environment

Configuration
Summaries>
X Environment

Configuration
Summaries>
X Environment

Configuration
Summaries>
X Environment

Configuration
Summaries>
X Environment

Configuration
Summaries>
X Environment

Configuration
Summaries>
X Environment
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Do xp.cnf File

26. Enter the host address or name and path to the osfile.
boot _method TFTP
boot_host name
boot _path

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.

select FAMILY=XP100 boot path = 0s.350
select FAMILY=XP330 boot path 0s.330
select FAMILY=XP350 boot path 0s.350
select FAMILY=NC200 boot path 0s.500
select FAMILY=NC400 boot path 0s.500
select FAMILY=NC900 boot path 0s.900

Fill out Workbook line 53.

27. Enter the NFS read size and the path to the osfile.
boot method NFS
boot _path

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.

select FAMILY=XP100 boot path 0s.350
select FAMILY=XP330 boot path 0s.330
select FAMILY=XP350 boot path 0s.350
select FAMILY=NC200 boot path 0s.500
select FAMILY=NC400 boot path 0s.500
select FAMILY=NC900 boot path 0s.900

Fill out Workbook line 54.
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To xp.cnf File Setup Menu
Do Xp.cittlile Paths
28. Enter the path to the OSfile. Configuration
boot _method MOP Summaries>
boot _path Boot

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.
select FAMILY=XP100 boot path ~ XP350 O0S

select FAMILY=XP330 boot path N __XP330_0S
select FAMILY=XP350 boot path N __XP350_0S
select FAMILY=NC200 boot path N __XP500_0S
select FAMILY=NC400 boot path XP500_0S

select FAMILY=NC900 boot path __ NC900 0S
Fill out Workbook line 60.

29. Enter the host address or name and path to the osfile. Configuration

boot _method 2 TFTP Summaries>

boot_host_name_ 2 Boot

boot _path 2

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.

select FAMILY=XP100 boot path 0s.350
select FAMILY=XP330 boot path 0s.330
select FAMILY=XP350 boot path 0s.350
select FAMILY=NC200 boot path 0s.500
select FAMILY=NC400 boot path 0s.500
select FAMILY=NC900 boot path 0s.900

Fill out Workbook line 53.
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Do xp.cnf File

30. Enter the NFS read size and the path to the osfile.
boot _method 2 NFS

boot _path 2

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.

select FAMILY=XP100 boot path = 0s.350
select FAMILY=XP330 boot path 0s.330
select FAMILY=XP350 boot path 0s.350
select FAMILY=NC200 boot path 0s.500
select FAMILY=NC400 boot path 0s.500
select FAMILY=NC900 boot path 0s.900

Fill out Workbook line 54.

31. Enter the path to the OSfile.
boot method 2 MOP
boot _path 2

If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.

select FAMILY=XP100 boot path _ XP350 0S
select FAMILY=XP330 boot path = XP330 0OS
select FAMILY=XP350 boot path =~ XP350 0OS
select FAMILY=NC200 boot path =~ XP500 _OS
select FAMILY=NC400 boot path =~ XP500 _OS
select FAMILY=NC900 boot path =~ NC900_OS

Fill out Workbook line 60.
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To Setup Menu

xp.cnf File Paths

Configuration
Summaries>
Boot

32. If you have a Flash Memory card you can optionally read an
xp.cnf file during subsequent boots by specifying a boot method
other than ROM (either MOP, TFTP or NFS) and a host address
or name and path to the xp.cnf file.

boot_method 2
boot _host_ 2
boot _path 2
If you have multiple families of network computers, replace the
boot_path command with the applicable select commands.

34. Set booting to be from values stored in NVRAM, instead of
values obtained from the network.

determine address_from NVRAM

35. Enter the address or name of the default Telnet host.
default telnet host

select FAMILY=XP100 boot path = 0s.350
select FAMILY=XP330 boot path 0s.330
select FAMILY=XP350 boot path = 0s.350
select FAMILY=NC200 boot path 0s.500
select FAMILY=NC400 boot path 0s.500
select FAMILY=NC900 boot path 0s.900
33. Set booting to be from a flash-equipped master network Configuration
computer. Use the name or address of the master network Summaries >
computer. Boot
boot method TFTP
boot_host
boot path /rom/os.<models>
select TERMINAL NAME=__ enable tftp daemon YES

Configuration
Summaries>
Boot

Configuration
Summaries>
TCP/IP
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To xp.cnf File Setup Menu
Do * Paths
36. Enter the address or name of the default CTERM node. Configuration
default cterm host Summaries>
TDEnet
37. Enter the parameters for Serid port O. Configuration
data_bits 0 Summaries>

stop bits 0 Periphera Ports

parity 0

flow control 0

baud_rate 0

38. Enter the parameters for Serid port 1. Configuration
data_bits 1 Summaries>

stop bits 1 Periphera Ports

parity 1 -

flow_control 1

baud_rate_1

39. save_current_settings Not available

40. Add an address or name for the XDM CP hosts to appear at the Not available
top of the HostMenu XDMCP list.

xdmcp_menu_entry

xdmcp_menu_entry

xdmcp_menu_entry

Continue adding entries as needed.
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To . Setup Menu
Do xp.cnf File Paths
41. Add an address or name for all preferred nodes to appear at the Not available
top of the HostMenu VM S TDEnet list.
vms_menu_entry TDEnet PREF
vms_menu_entry TDEnet PREF
vms_menu_entry TDEnet PREF

Add an address or name for al other nodes to appear on the
HostMenu VMS TDEnet list.

vms_menu_entry TDEnet _ ____ NOTPREF
vms_menu_entry TDEnet _ ____ NOTPREF
vms_menu_entry TDEnet NOTPREF

Continue adding entries as needed.

42. Add an address or name for all preferred nodes to appear at the Not available
— top of the HostMenu VMS TCP/IP list.
vms_menu_entry TCPIP PREF
vms_menu_entry TCPIP PREF
vms_menu_entry TCPIP PREF

Add an address or name for al other nodes to appear on the
HostMenu VMS TCPIP list.

vms_menu_entry TCPIP _____ NOTPREF
vms_menu_entry TCPIP _____ NOTPREF
vms _menu_entry TCPIP NOTPREF

Continue adding entries as needed.
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To .
Do xp.cnf File

43. Add an address or name for all preferred hosts to appear at the
top of the HostMenu TELNET list. Specify the emulator to use
for the session (TEK 220 or TEK340).

telnet menu entry PREF
telnet menu entry PREF
telnet menu entry PREF

Add an address or name for al other hosts to appear on the
HostMenu TELNET list. Specify the emulator to use for the

session (TEK 220 or TEK 340).

telnet _menu entry = NOTPREF
telnet _menu entry =~ NOTPREF
telnet_menu entry NOTPREF

Continue adding entries as needed.

44, Add an address or name for all preferred nodes to appear at the
top of the HostMenu CTERM list. Specify the emulator to use
for the session (TEK 220 or TEK340).

cterm_menu_entry PREF -
cterm menu_entry PREF
cterm menu_entry PREF

Add an address or name for al other nodes to appear on the
HostMenu CTERM list. Specify the emulator to use for the
session (TEK220 or TEK 340).

cterm_menu_entry NOTPREF _ _
cterm_menu_entry NOTPREF _ _
cterm_menu_entry NOTPREF _ _

Continue adding entries as needed.
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To xp.cnf File Setup Menu
Do xp.cnitile Paths

45. Add an address or name for all preferred IBM hosts to appear at Not available
the top of the HostMenu IBM list. Specify the emulator to use
for the session (TEK3270), the model (2, 3, 4, 5), and the
protocol (TN or OCS). Note, the Teemx emulator is not yet
supported in the HostMenu.

ibm menu entry PREF .
ibm menu entry PREF .
ibm menu entry PREF

Add an address or name for all other IBM hosts to appear on the
HostMenu IBM list.

cterm_menu_entry _ NOTPREF __
cterm_menu_entry _ NOTPREF __
cterm_menu_entry _ NOTPREF __

Continue adding entries as needed.

46. Add an address or name for all preferred Windows NT servers Not available
to appear at the top of the HostMenu WinDD list. Specify the
window size to use for the session (640, 800, 1024, 1280),
whether to reconnect after a session log off (NORECONNECT,
RECONNECT), and whether to display the menubar
(MENUBAR, NOMENUBAR).

windd menu entry _ PREF ___ -
windd menu entry _ PREF __ -
windd menu entry =~ PREF

Add an address or name for al other WinDD servers to appear
on the HostMenu WinDD list.

windd menu entry NOTPREF __
windd menu entry NOTPREF __
windd menu entry = NOTPREF

Continue adding entries as needed.
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To .
Do xp.cnf File

47. Add the name or address and configuration information for the
Windows NT server when the host_connect_method is set to
WINDD. windd_size can be 640, 800, 1024, 1280).
windd auto_connect, windd auto_reconnect, and
windd_entrybox can be set as ENABLED or DISABLED.
windd_menubar can be set as YES or NO.

windd host name

windd size

windd_auto_connect

windd auto_reconnect

windd_menubar

windd_ entrybox

48. Edit the gateway.thl file and enter as many additional gateways
as needed.

49. Edit the hosts.thl file and enter as many additional hosts as
needed.

50. Edit the file nodes.tbl and enter as many additional nodes as
needed.

2-34 NCBridge for Windows NT Installation and Configuration Manual

Setup Menu
Paths

Not available

Network Tables
and Utilities >
Gateway

Network Tables
and Utilities >
Internet Host

Network Tables
and Utilities >
TDEnet Host



Configuration Wor kbook

To . . Setup Menu
Do .tbl Files Paths
51. Edit the nfs.thl file and enter as many additional NFS mounts as Network Tables
_ needed. and Utilities>
NFS Mount
52. Edit the fonts.thl file and enter the directory paths (Example: Network Tables
tekxp/boot/fonts/misc or tcp/192.43.153.204:7100). and Utilities>

Font Directory
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2-36

To

Host Configuration Procedures

53. Enable tftp on the host.

54. Enable NFS on the host.

55. Enable bootp on the host.

56. Enable DHCP on the host (see Chapter 5).

57. Enable rarp on the host.

58. Enable XDM on the host.

59. Add network computer entries to /etc/host file.

60. Enable MOP on the host.

61. Add the nodes to the NCP database.

62. Create Proxy accounts on the host.

63. Enable DECwindows on the host.
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Supporting a Centralized System

ski
chuc
fred
letc/hosts

This chapter contains procedures for setting up the necessary operating system
support files. Use the Workbook in Chapter 2 to determine the procedures
needed.

Y our environment and the features you enable dictate the operating system
tasks. Y ou must be root to modify the host files.

» NFSdirectories must be exported if NFSis used for booting or file access.

* DHCP must be configured so it automatically determines configuration
information over the network.

» Severd Local Clientsare available and can be started with xpsh or the Client
Launcher (See Chapter 4, Local Clients).

» Local Motif Window Manager (MWM) must be started to use local MWM
(See Chapter 5, Window Managers).
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Enabling NFS

This section isan overview that describes how to enable NFS on your NT host
if NFSis used asthe boot_method or file_access method. Refer to your NFS
documentation for specifics on installing and setting up NFS on your host.

1. Add the boot_directory (\tekxp\boot) to be exported on the host. Export as
read only. Refer to your NFS documentation for information on the name
and location of the exportsfile.

2. Edit the %SYSTEMDRIVE%%SYSTEMROOT%\system32\driver s\etc\hosts
file and add the network computer name and address.

128.07.60.30 portland

3. Toenablethe mount point immediately, openthe NFS > NFS Server diaog.
Click Exports. Press Add to add and verify mount points.

4. Open Main > Servicesto verify NFSisrunning.

Booting via NFS on a WinDD Server
To enable aWinDD server to be an NFS boot host:
1. Onthe WinDD server, log in asthe local administrator.
2. Open the Administrative Tools > User Manager for Domains window.

3. Create two new users, assigning each a password. For example, boot1 and
boot2.

4. Choose File > Run and enter nfs.exe. In the NFS Server dialog, click Users.
The two new users appear in the Server Users dialog.

5. Select thefirst user and enter the password in the User Password field. Enter
OintheUser ID field, and 1 in the Group 1D field. Click M odify.

6. Select the second user, and enter the password in the User Password field,
Ointhe User ID field, and 0 in the Group I D field. Click M odify.

Y ou can now boot from the WinDD server.
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Configuring the Microsoft DHCP Server

Note: |If the DHCP isnot properly configured, multiple network
computers could be assigned the same | P address.

The Microsoft DHCP Server provides boot configuration information for NCD
network computersafter you add two new N CBridge DHCP Options (or vendor
tags) to the DHCP server. If DHCP isnot on your NT server:

* Install the Microsoft DHCP Server on the application server. For online
installation help, refer to WindowsNT Help > Additional Networking
Services for Windows NT Server > TCP/IP > Installing and Configuring
DHCP Servers.

» Reboot the system after installing DHCP. The DHCP Server isautomatically
started.

The DHCP Manager administers the DHCP server. It is available through the
Network Administration program group. Initialy, the L ocal Machine entry is
predefined and there are no scopes nor DHCP Options defined. When the first
scope is created, the DHCP Options are created in the Registry.

Creating the NCBridge Scope

To set up the scope of NCD network computers you plan to manage and
configure with the DHCP Server: L ocal M achine, you must do the following:

1. Open the Network Administration group from the Program Manager.

2. Open the DHCP Manager icon.

3. Create the scope of the NCBridge | P addresses. Y ou must provide at |east the
start and end range of addresses and the subnet mask. Onlinehelp for creating
scopes can be found in the DHCP Manager Help.

4. Select DHCP Options > Defaults.
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5. Click New. Add the following information to create the 066 (boot server
address) vendor tag:

Name: Boot Server address
Data Type: String
Identifier: 066

Comment: (Thisisan optional, user-defined field.)
When complete, click OK to create the option.

6. To define the default value of the string, select the 066 Boot Server entry in
the Option Name entry box. The current va ue of the string should display as
an empty box. If you are using NFS to boot the network computer, select the
box and enter the | P address of the Boot Server, in this case, the | P address of
Local Machine.

7. Click New. Add thefollowing information to create the 067 (boot file) vendor

tag:

Name: Boot File
Data Type: String
Identifier: 067

Comment: (Thisisan optional, user-defined field)
When complete, click OK to create the option.

Note: For steps5 and 7, the identifiers do not need to be created
when running Windows NT 4.0 Server and Terminal Server
Edition.
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8. It may be appropriateto leave the default val ue of this option as ablank string
and define it either at the scope or client lease level. If thereisonly asingle
osfileto service any DHCP Server request, you can define it as the default
string value. To define the value of the string at the DHCP Option: Default
value, select the 067 Boot File entry in the Option Name entry box. The
current value of the string should display as an empty box. If you are using
NFS to boot the network computer, select the box and enter the NFS path of
the appropriate boot file directory for the network computer model,
\tekxp\boot\ for example.

- Todefine the values of the DHCP Options at the Scope level, select a
scope from the DHCP Servers column, then select DHCP Options >
Scope.

- To define the values of the DHCP Options at the Client L ease level,
select the Scope where the Client Lease entry can be found. Select
Scope > Active L eases. Select the Client Lease entry and click
Properties. In the new Client Properties window, select Options.

Note: |f the option isnot an Active Option, select it from the
Unused Options list and use the Add button to makeit an
Active Option. Select the Option in the Active Options List
and click Value. The current value shows up in the value
box at the bottom which you can then edit. Click OK to
accept any changes.

9. For NFS booting of NCD network computers, we suggest that the scopes
and/or leases defined to support the network computers contain the foll owing
DHCP Options:

003 Router Gateway number
066 Boot server address/Primary boot host address
067 Boot file/Primary boot path
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Chapter 4

Local Clients

Thischapter describesvariouswaysto start alocal client. Local clientsare those
applications that execute on the network computer, rather than on the host, thus
reducing network traffic. HostMenu, Telnet, Cterm, and Setup are examples of
local clients. Local clients can be started with xpsh, the remote configuration
file (xp.cnf), with rsh, or with the Client Launcher.

This chapter also describes the Client Launcher, Audio Server, Authorization
Key Manager, and Touchscreen Calibration.
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Thefollowing local clients are available on the network computer:

Audio Mixer .
Audio Player .
Authorization Key Manager .
Cterm session .
Digital Video Player .

LAT session .
Local Client Launcher .
Motif Window Manager (MWM)

Netscape NC Navigator

Serial session

Setup

Teemx 3270E/5250 Emulators
Telnet session

Touchscreen Calibration
WinDD ICA client

Xlock client

XP Window Manager (XPWM)

Note: Netscape NC Navigator, MWM, LAT, Cterm, Teemx
emulators, and the Tek340 emulator requirean authorization
key. All NC900 products are shipped with an authorization
key for Netscape NC Navigator and Tek340 emulator |oaded.
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Starting Local Clients with xpsh

xpsh isahost program used to download local clients to a network computer.
It isatwo-way communication mechanism between the host program (xpsh)
and thelocal daemon (xpshd). xpsh sendsinformation to the network computer
specifying which local clientsto download, and xpsh receives|ocal client error
messages and exit information from the network computer. xpsh can download
and start local clients.

Starting aclient using xpsh enablesthe client to run locally instead of from the
host. The host environment, client name, and arguments are sent to the local
network computer. For example, using xpsh to download MWM enablesaccess
tofilesin %HOM EDRIVE%%HOMEPATH%. This allows you to customize
the MWM environment for an individual user.

Notes: When starting local clientswith xpsh, -display nc_name:0
must be used from Windows NT. | f thereisan |CA
connection to an NT Terminal Server host, the NT
environment variable “ CLIENTNAME" can be used to start
local clients. For example:

xpsh -display %CLIENTNAME%:0.0 mwm

Then when starting local clientswith xpsh, enter xpsh and the
local client only. For example:

xpsh -display nc_name: 0.0 -access xpsh netscape
xpsh -display nc_name:0.0 tek220 -e cterm

xpsh -display nc_name: 0.0 tek340 -e telnet

xpsh -display nc_name: 0.0 -access xpsh mwm
xpsh -display nc_name:0.0 tek220 -e llogin

xpsh -display nc_name: 0.0 tek220 -e tip ttyO

xpsh -display nc_name: 0.0 tek340 -e tip ttyl

xpsh -display nc_name: 0.0 xlock -mode 1

xpsh -display nc_name: 0.0 setup

xpsh -display nc_name: 0.0 -access xpsh teemx

To start alocal client using xpsh, enter the appropriate command as explained
in the preceding note and in the topics that follow.
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Starting the Audio Mixer

xpsh -display nc_name:0 mixer

Starting the Audio Player
xpsh -display nc_name: 0 aplay
The following options can be set on the xpsh command line:

-h  host specifies the host name or address on which the audio file resides.
The host must be entered in the network computer’ s Internet Host Table
in Setup. Thishost displaysinthe Audio Player’s File Information area.

-f  filename and path specifies the audio file name and its entire path. This
file displaysin the Audio Player’s File Information area.

-a access method specifiesthe access method used to accessthe audiofile.
Available access methods are tftp, nfs, and dap.

-v  volume level specifiesthe volume level to use when playing the audio
file. Specify anumber between 0 and 100, with O indicating no volume,
and 100 indicating the loudest volume setting.

-p  when used with the -h, -f, -a, and -v options, the specified file plays
without opening the Audio Player. The entire file plays and cannot be
interrupted.

Starting the Authorization Key Manager
Xpsh authkey

The network computer reads the authkey.dat file when booting and updates
the network computer and authorization key information. (Be sure that
SNMP is available and enabled.)

Starting a Cterm Session
A Cterm session can be started with a Tek220 or Tek340 emulator.

xpsh -display nc_name: 0 tek220 -e cterm
xpsh -display nc_name: 0 tek340 -e cterm

Resource settings can be specified for a Cterm session. Refer to the next
section, Specifying Client Resource Settings.
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Starting the Digital Video Player

Note: Not available on NC900 Series.
xpsh -display nc_name:0 vplay
Y ou can set the following vplay options on the xpsh command line:

-h

host specifies the host name or address on which the video file resides.
The host must be entered in the network computer’ s Internet Host Table
in Setup. This host displaysin the Video Player’ s File Information area.
When Multicasting, -h specifies the |P address. The port number
displaysin the Video Player’s Addr/Port Information area.

filename and path specifies the video file name and its entire path. This
file displaysin the Video Player’s File Information area. When
Multicasting, -f specifies the port number. The address displaysin the
Video Player’s Addr/Port Information area.

access method specifies the method used to access the video file.
Available access methods are tftp, nfs, dap, and Multicast. NFSisthe
preferred file access method for faster and more accurate data transfer
rates required by the player. In addition, thereisa 16MB limit on files
transferred with TFTP.

volume level specifiesthe volume level to use when playing the video
file. Specify anumber between 0 and 100, with 0 indicating no volume,
and 100 indicating the loudest volume setting.

(Mute) specifiesthat the video file plays with no sound.

(Color) specifies that the video file displaysin color (used only if the
video was recorded in color).

-nc (No Color) specifies that the video file displays in greyscale images.
-brightnessn  setsthe brightnesslevel of thevideo file. Specify anumber

between -50 and +50.

-contrast n sets the contrast level of the video file. Specify a number

-b

P

between -50 and +50.

(Big) specifiesthat the video file displaysin aframe four times the size
of the origind file.

(Playonly) when used with the options above, the specified file plays
without showing the Video Player. The entire file plays and cannot be
interrupted.
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-all  (Play All; software player only) playsall framesinavideofile. Frame
scheduling is ighored and the audio is not put into sync.

-title  “string” — assigns atitle for the vplay windows.

-propcmd
creates properties that allow other clients to send command strings to
the Video Player. These properties cannot be changed or modified and
are used to control the Video Player from another client that you
create. For details about the properties, see the vplay man page.

-BUFSIZE n
(Hardware Player only) specifies the size of the Video Player's
memory buffer (in kilobytes). The value defaults to 1024 and can not
be set lower than 1 kilobyte. If the value specified is greater than
available memory when trying to play afile, the Video Player reduces
its buffer to the available memory.

-CHKSIZE n
(Hardware Player only) specifies that the Video Player's memory
buffer isdivided into “chunks’, measured in kilobytes. The network
fills the chunks, and the Video Player empties them as they are
accessed. The default is 32, which divides the buffer into 32 kilobyte
chunks. If the chunk sizeis set to anumber larger than the buffer size,
the chunk size istruncated to one half the buffer size. The chunk size
cannot be set less than 1 kilobyte.

-CHKDELAY n
(Hardware Player only) specifiesthetime delay (in milliseconds) that
the Video Player waits following each read request that fills a chunk.

-chann
(Multicast only) specifies an index into an array of available
Multicast channels. Do not use with the -h, -f, -a, or -text options.

-text "string”
(Multicast only) specifies the channel string to be displayed by the
Video Player. Do not use with the -chan option.
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Starting a LAT Session

A LAT session can be started with a Tek220 or Tek340 emulator.

xpsh -display nc_name:0 tek220 -e llogin
xpsh -display nc_name:0 tek340 -e llogin

Resource settings can be specified for aLAT session. Refer to the next
section, Specifying Client Resource Settings.

Starting the Local Client Launcher
xpsh -display nc _name:0 launcher

Thefollowing options can be added to the xpsh command line when starting
the Client Launcher:

-auto configures the Client Launcher with the automatic default settings
even if aconfiguration file exists.

-file filename configures the Client Launcher using a user-defined
configuration file.

Starting Local MWM
xpsh -display nc_name:0 mwm

Note: |f both MWM version 1.1 and MWM version 2.0 are
authorized, the 2.0 version starts. I n this case, to start
version 1.1, use mwmvl instead of mwm in the command.
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Starting Local Netscape NC Navigator

All NCD Network Computers come authorized to run the local Netscape NC
Navigator browser which ships with NCBridge. Additional memory may be
required, however.

NCD recommends that the network computer have at least 48MB of system
memory for running the local browser. Y ou can start thelocal browser in either
kiosk mode (see the Kiosk Mode topic in the NCBridge Reference Manual) or
by using xpsh. For example, after logging in, use one of these commands to
start the local browser:

xpsh -display displayname:0.0 -access xpsh netscape
xpsh -display displayname:0.0 -access xpsh netscape lite

These commands assume that xpsh is in the user’ s search path. The default
location is ¢: \NCBridge\tekxp\bin\nt. You must usethe

-display displayname: 0.0 command line option, where “ displayname” isthe
IP address or hostname of the NC. If connected to an NT host using the local
ICA client, use “-display %CLIENTNAME%:0.0". See both the NCBridge
User Manual and the NCBridge Reference Manual for additional details on
running the local browser.

Notes: Thetimerequired to start the local browser can be
significantly reduced by preloading it during the boot process.
Prior to NCBridge 4.0, the browser was automatically
preloaded. NCBridge 4.0 does not preload the browser. The
administrator must specify the preloading of the browser in
the xp.cnf file.

When using local Netscape, the NC must be configured to
boot using NFS. When booting via TFTP, local Netscape
takes about 5 to 10 minutesto start.

Starting a Serial Session for Port 0 and Port 1

A serial session can be started with a Tek220 or Tek340 emulator for port O or
port 1.

xpsh -display nc_name:0 tek220 -e tip ttyo0
xpsh -display nc_name:0 tek340 -e tip ttyl
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Starting Setup
xpsh -display nc_name:0 setup

A network computer’s Setup and Console window can also be started and
displayed on aremote network computer or host using xpsh. Once started,
you can use Setup to configure network computer settings, establish
communication connections, and monitor network computer operations.

To access a network computer’ s Setup from aremote network computer or
host using C shell, enter:

setenv TEKSETUP_DISPLAY display_device: o
Xpsh -displayhc:0 setup
If using adifferent type of shell tool, enter:
xpsh -display nc:0 -xpenv “TEKSETUP DISPLAv=display device:0” setup

where nc is the remote network computer whose Setup and Console window
isaccessed, and display_device isthe network computer or host where Setup
istodisplay. Use P addressesif theremote network computer does not know
the host name of the display device (set up in the Internet Host Table in
Setup).

To access a hetwork computer’ s Console window from a remote network
computer, first display the remote NC Setup window on your NC as
described earlier in this topic. Then click the Network Tables and Utilities
button and select Console from the drop-down menu to open the Console
window.

If the network computer user currently has Setup started, it is not accessible
remotely viaxpsh. Likewise, if aremote network computer or host has Setup
open viaxpsh, it isnot available to the network computer user.

Note: To prevent other users from accessing your network
computer’s Setup and resetting the server, set
enable_access_control to Yes (in either the xp.cnf fileor in
Setup).
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Starting Teemx 3270E/5250 Emulators

xpsh -display nc_name:0 teemx

See the Teemx 3270E/5250 User Manual on the Documentation CD-ROM
for details.

Starting a Telnet Session

A Telnet session can be started with a Tek220 or Tek340 emulator.

xpsh -display nc_name:0 tek220 -e telnet
xpsh -display nc_name:0 tek340 -e telnet

Resource settings can be specified for a Telnet session. Refer to the next
section, Specifying Client Resource Settings.

Starting WinDD

xpsh can start the WinDD ICA client as heeded. To start the WinDD ICA
client with xpsh, enter the following (where nc_nameisthe name or address
of your network computer):

xpsh -display nc_name: 0 windd [options]
The following options can be set on the xpsh command line:

-display nc:0
Specifies the nc name or address to display the WinDD local client.

-c  Auto-connect to thefirst application server in the application server list.
If there are no application serversin the list, this option isignored and
the client window is displayed.

-nc Do not auto-connect to an application server. (Default)
-d Displaysthe menu bar and the internal borders. (Default)

-nd Does not display the menu bar or theinternal borders. For example, this
allows a 1280x1024 WinDD window to fully display on a 1280x1024
monitor (minus windows manager decorations).

-e Enablesthe Application Server edit field window so that users can add
application serversto the application server list. (Default)

-ne Disablesthe Application Server edit field window so that users are not
allowed to add application servers to the application server list.

NCBridge For Windows NT Installation and Configuration Manual



Sarting WinDD

-floppy
Allows supported host versions of WinDD to useitslocal floppy drive

as anetwork connected drive for the Application Server. Only the first
host client to specify this option is alowed to use the floppy device.
Note, thisis for host clients (with local floppy drive) only.

-no_floppy_cache
Disables use of local floppy write cache. Thisis afail-safe option to
ensure the entire file has been updated in the event a user suddenly
gjects a disk mechanically (when disks are gected via the GUI button,
that process flushes the cache so no information islost).

-geometry <geometry>
Standard X 11 geometry option, <WidthxHeight+X+Y >.

-h <application server>
Adds the named application server(s) to the application server list.
Multiple application servers can be added to the list by listing them
separated by spaces.

-help
Displays abrief help list on the available WinDD command-line
options.

-initprog <prog> [-initdir <dir>]
Specifies the application to execute upon application server login. The
login session is terminated when the application is terminated.

Prog specifies the application and can also specify its path (up to 259
characters) and parameters. The program path and name are written
consecutively (and not separated by a space) when they are both
specified in prog. A space separates the program name and its
parameters. These parameters are program specific and can specify
program settings or datafiles to invoke on execution. Dir specifies the
path of the executable program.

-keysym_only
Specifiesthat all NCD network computer keyboards are supported with
keysym translations within WinDD.

-local_numlock
Specifiesthat WinDD manages the state of the Num_L ock independent
of any X server support.
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-no_auto_numlock
Specifies that WinDD does not control the Num_L ock setting.

-login <username> [-pass <passwd>] [-domain <domainname>]
Specifies the application server user account login name, login
password, and domain. These values are used for user account
verification.

When using aWinDD client and connecting to a WinDD application
server, your username, password, domain, initial program, and initial
directory are encrypted as they are sent across the network.

Username, password, domainname, dir, and prog are not viewable or
changeable from the WinDD configuration window.

-r  Reconnect to the application server after log off.
-nr Does not reconnect to the application server after log off. (Default)

-version
Displaysthe WinDD versionin use. (If the license is 8019, this option
also prints For evaluation purpaoses only.)

-x  Exitsthe WinDD client upon logging out of, or disconnecting from, the
application server.

-nx Does not exit the WinDD client upon logging out of, or disconnecting
from, the application server. (Default)

-force_xcursor
Specifies that monochrome pointers within the WinDD desktop are to
be implemented using X cursors. Some monochrome pointers are xor’ d
with the underlying desktop. When this switch is specified, it isno
longer xor'd, as X cursors do not support that mode.

Note: Theforce xcursor featureisintended to compensate for
workstations that do not have a particularly high
performance X server. Consider using thisoption if the
pointer flashes when moved, or poor performanceis
observed entering text in dialog boxes. Using this switch
improves user interactivity. The only side effect isthe
pointer is displayed in a single color.
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Starting Xlock
xpsh -display nc_name: 0 xlock -mode <mode>

where <mode> is an optional setting. If set to 1, Xlock locks the keyboard
only. If set to o, Xlock locks the keyboard and the screen. If a mode setting
is not given, Xlock locks the keyboard and the screen by default.

A password is required to use the Xlock client. The same password is used
throughout the entire session. If while using Xlock you forget the password,
you must reboot the network computer or reset the server (in Setup) to clear
the password and unlock the keyboard and screen.

Starting Local XP Window Manager

Xpsh -display nc_name: 0 xpwm

Starting Local Clients in the xp.cnf File

Using the start and/or preload commands in the remote configuration file
(xp.cnf), you can determine which local clients are downloaded and/or started
at boot time. The specified clients are loaded into the network computer’s
memory and remain there until started. Even after closing the client, it remains
in RAM so that it can be restarted again. For information about starting local
clients from the remote configuration file, refer to the start and preload
commands in Chapter 2, Remote Configuration in the NCBridge Reference
Manual.

Starting Local Clients with rsh

rshisahost program used to download local clientsto anetwork computer. r sh
sends information to the network computer specifying which local clients to
download, however, unlike xpsh, rsh does not receive local client error
messages and exit information from the network computer.

Security for rsh is set through the .rhosts file. If user security isnot setin

the .rhostsfile, then users are ableto access all local clients. Thershd_security
command in the remote configuration file (xp.cnf) is used to determine whether
users can override the security features set by the system administrator.
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Enabling rsh

Before starting local clientswithrsh, you must first enableit. Todo this, usethe
start command with the parameter RSHD in the remote configuration file
(xp.cnf):

start RSHD Yes

Editing the .rhosts File

4-14

The .rhostsfileis used to authenticate user requests to execute local clients.
Entries are either positive or negative, depending on the permissions you want
to give users. Positive entries enable user to access the specified local clients;
negative entries deny access. The entries should include the hostname,
username and client name. The order of entrieswithin thefilesisimportant. If
the file contains both positive and negative entries, the entry that appears first
takes precedence.

Examples

For example, the entry below allows user judyl access to the Setup and Client
Launcher clients while logged into the host Sierra:

serra  judyl +setup +launcher

If you do not list specific clients, then al clients are available to the specified
user:

sierra  judyl
A negative entry means that the client is not available to the user, but all other

clients are. For example, user judyl cannot access the Digital Video Player or
the Audio Player, but can access any of the other available clients:

serra  judyl -vplay -aplay
Y ou can a so use the positive and negative specification for hostname and

usernames. Inthefollowing example, user paulb can accessall clientsfrom any
remote host:

+ paulb

In the next example, any user from any host can access the Setup and L auncher
clients:

+ + +setup  +launcher
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In the final example, user davidb is not allowed access to the Setup and Xlock
clients from any host:

+ -davidb +setup +xlock

For details about the .rhosts file, refer to the rhosts man page for your host.

Starting Local Clients with rsh

rsh uses the same local client options as xpsh. When using r sh to start clients,
you do not enter the -display environment variable, and you must use the
network computer name instead of an address. For example, to start Setup with
rsh:

rsh nc_name setup
For details about starting local clients using rsh, refer to the Sarting Local

Clients with xpsh section earlier in this chapter and substitute r sh for xpsh and
omit the -display environment variable and the :0 in all examples.

Notes: rsh can start all thelocal clientsthat xpsh can start, except the
Remote Setup client, Navio, Netscape, Netscape_Lite, and
Teemx.

Remote setup implies that the Setup screen from an NC is
displayed on another X server device over the network.
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Client Launcher

Thelocal Client Launcher allows usersto start local clients by simply selecting
aclient from a menu using the mouse. Figure 4-1 shows a sample Client
Launcher menu. The Client Launcher can be configured automatically using
default options, or with a customized configuration file. It can be downl oaded to
the network computer using the remote configuration file (xp.cnf) or using xpsh.

[®] Launcher .

Setup

Console

Lock Screen
Hosthenu

Host Connections .-
Window Managers .-
tMultimedia =
QUIT

Figure 4-1 Client Launcher Menu

Configuring the Client Launcher

4-16

There are two ways to configure the Client Launcher: default automatic
configuration, or with a specific configuration file. When the Client Launcher
is started, if a user-defined configuration fileis not specified, it first searches
for a system.launcher configuration file. (A sample system.launcher fileis
located in \tekxp\boot\config.) If that file is not found, it configures
automatically.
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Automatic Configuration

If thereis no configuration file present, the Client Launcher automatically
configures and includes the following clients by default: Telnet, HostMenu,
Lock Screen, Console, and Setup. Serial Port 0 and/or 1 are included if the
network computer has serial ports. If Motif Window Manager (MWM),
TDEnet, LAT, or Tek340 are authorized, they areincluded aswell. The Audio
and Video players are included if authorized and if the required hardware is
present.

Configuration Files

The configuration files are accessed when the Client Launcher starts, and are
used to determine which clients are available to users. There are two different
types of configuration files:

» The system.launcher file configures multiple network computers so that the
clientsavailable on the Client Launcher are the samefor all who use thefile.
This allows a system administrator to control which clients are available to
users.

» A user-defined configuration file customizes the Client Launcher for auser.
To create a configuration file:

1. Create anew file, naming it either system.launcher for a system-wide
configuration file, or whatever you like for a user-defined file, for example,
launch. A sample system.launcher fileislocated in \tekxp\boot\config.

2. Movethe new fileto the ssmedirectory where the xp.cnf fileislocated. (The
default location is \tekxp\boot\config.)

3. Inthefile, use atext editor to enter the main Client Launcher menu hamein
uppercase letters.
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4. On subsequent lines, enter each of the clients and submenu names (if used)
in double quotation marksto include on the Client Launcher followed by the
f.exec or f.menu option:

f.menu specifiesthat a submenu is available with additional options. For
example, if you have both Motif Window Manager (MWM) and
XP Window Manager (XPWM) authorized, you could have a
Window Manager s entry on the Client L auncher menu that opensa
second menu containing MWM and XPWM. Y ou can use any
name or description you like in the Client Launcher file with the
f.menu option; however, it must end with the string “MENU”, for
example:

#”Window Managers f.menu WMMENU

#WMMENU

#” mwm” f.exec “mwm”
#” XPWM” f.exec “xpwm”
#ENDMENU

f.exec  specifiesalocal client to startimmediately upon selecting it. Enter
the client name exactly as you would on the xpsh command line,
usually with al lower caseletters and with double quotation marks.
For example, “telnet”, “console”, “setup”, and “mwm”.

The order in which you enter clients and submenus in the configuration file
determines the order they appear on the Client Launcher.

5. On the last line of the main menu, enter ENDMENU in uppercase | etters.

6. Createthe submenus, if used, by entering the submenu namein all uppercase
letters. On subsequent lines, list the clients to include followed by f.exec
option in the same manner described in Step 4.

7. On thelast line of each submenu, enter ENDMENU in uppercase letters.

The Client Launcher menu in Example 4-1 contains the following entries:
Sessions (displays a submenu of available session clients), Multimedia
(displays a submenu), Console, HostM enu, Window Managers (displays a
submenu), and Setup.

NCBridge For Windows NT Installation and Configuration Manual



Configuring the Client Launcher

Example 4-1 Sample Client Launcher Configuration File
# Configuration file for Client Launcher

#

MAINMENU
"Sessions"
"Multimedia"
"Console"
"HostMenu"

"Host Connection"
"Window Managers"
n Setup n

"EXit n

ENDMENU

SESSIONS
"Serial 0"
"Telnet 220"
"Telnet 340"
ENDMENU

MULTIMEDIA
"Audio Player"
"Digital Video"
"Audio Mixer"
ENDMENU

WINDOWS
n MWM n

n XPWM n
ENDMENU

HOSTMENU
"Netscape Lite"

ENDMENU

Fh Fh Fh bhoHh Fh D b

FhoFh

.menu
.menu
.exec
.exec
.menu
. menu
.exec
.exec

.exec
.exec
.exec

.exec
.exec
.exec

.exec
.exec

.exec

SESSIONS
MULTIMEDIA
"console"
"HostMenu"
HOSTMENU
WINDOWS

n setup n

n q'l.llt n

"tip -e tip ttyo"
"xterm -e telnet"
"tek340 -e telnet"

"aplay -v 50"
"vplay -v 50"
"mixer"

n mwm n

n Xpwm n

"netscape lite"

Inthepreviousexample, thef.exec optionimmediately startsaclient or session,
and the f.menu option specifies that a submenu is to appear. The word
ENDMENU specifies the end of the menu options.

The main Client Launcher menu contains the MAINMENU entries of the
configuration file. When Sessions or Window Managers is selected, the

appropriate submenu displays.
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Downloading the Client Launcher

The Client Launcher can be downloaded using the remote configuration file
(xp.cnf) or with xpsh.

Downloading Using the xp.cnf File

The start command in the xp.cnf file can be set to automatically download and
start the Client Launcher when the network computer boots. For information
about the start command and avail able parameters, refer to Chapter 2, Remote
Configuration in the NCBridge Reference Manual.

Downloading with xpsh

When downloading and starting the Client Launcher using xpsh, the following
options can be set:

» -auto configures the Client Launcher with the automatic default settings
even if aconfiguration file exists.

+ -filefilename configures the Client Launcher using a user-defined
configuration file.

* -geometry X, y configures the position of the Client Launcher. A positive
entry (+x, +y) orients from the upper left corner of the display. A negative
entry (-X, -y) orients from the lower right corner of the display.

Examples

The following example downloads and starts the Client Launcher with
automatic configuration on the network computer sierra:

xpsh -display sierra:0 launcher -auto

The following example downloads and starts the Client Launcher with
automatic configuration on the network computer sierra and positionsit 30
pixels from the lower right corner:

xpsh -display sierra:0 launcher -auto -geometry -30-30

The following example downloads and starts the Client Launcher, configuring
its contents using a user-defined file named launch on the network computer
serra:

xpsh -display sierra:0 launcher -file\ /ul/user3/launch
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The following example downloads and starts the Client Launcher, configuring
its contents using the system.launcher file on the network computer rocky:

xpsh -display rocky:0 launcher

The following exampl e starts the Client Launcher with the automatic
configuration using the start command in the xp.cnf file:

start launcher -auto

Using the Client Launcher

Press the Shift and Setup keys simultaneously to display the Client Launcher
main menu.

When the Client Launcher is started, it searches for configuration information
in the following order:

* Inauser-defined configuration file, if specified.
* The system.launcher configuration file.

* If neither configuration file is found, the Client Launcher automatically
configures by listing all default and authorized clients.

To open aclient listed on the Client Launcher, simply position the mouse
pointer on the client name and click the mouse button once. To open asubmenu,
position the mouse pointer on the menu name. The submenu displays to the
right of the Client Launcher main menu (refer to Figure 4-2). Position the
mouse pointer an item in the submenu and click the mouse button once.

If the Client Launcher is iconified, pressing the Shift and Setup keys
simultaneoudy displaysit again. Thisisespecially useful if the Client Launcher
icon is hidden under other open files.
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Authorization Key Manager

The Authorization Key Manager enables a system administrator to easily
update the authorization keys of several network computers. Authorization
keys are used to authorize specia options used on the network computer, such
as Motif window manager, TDEnet (DECnet), and Teemx 3270E emulator.

Instead of entering each network computer’s authorization key one at atime,
you can update and maintain them from a central file. The Manager reads the
authkey.dat file, which contains the authorization keys for those network
computers you want to update with new options. When thefileis read, those
network computers listed in the authkey.dat file are updated with a new key.

How the Authorization Key Manager Works

The Authorization Key Manager uses SNMP to query specific broadcast
addresses and network computers listed in the authkey.dat file, or in the
Authorization Key Manager client. Those network computersare then assigned
anew authorization key, also listed in the authkey.dat file. Therefore, you must
have and enable SNMP.

Setting Up SNMP

In the xp.cnf file, use the snmp_comm _list command to set the community list
to public and to allow read and write permissions:

snmp_comm_list “host” public RwW

where “host” isthe host that performs the GET and SET operations when
guerying the subnet, public isthe community string, and RW indicates read and
write permissions.
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The authkey.dat File

The authkey.dat file is located in \tekxp\boot\config by default and is empty.
Edit the file to contain the broadcast address to query, the network computers
to update, and the new authorization keys. The following parameters are used
in the authkey.dat file:

br oadcast specify the broadcast address to query using SNMP.

terminal for each network computer you want to update with anew
authorization key, enter its hardware address.

authorization key  For each network computer, enter the authorization key.
Each network computer must have a unigue authorization

key.
The exampl e below shows a sample authkey.dat file:

broadcast 144.67.33.255

terminal 08:00:34:94:33:EJ JAB(4%>3+[=T;fjqgc
terminal 08:46:22:69:47:32 AK) &AMB@.?JTOR&] \
terminal 08:42:90:00:31:69 Jk%3+=]klw\jvv<?!
terminal 08:47:35:69:21:21 Uu$’gvuli#=/>1GLqg

Starting the Authorization Key Manager

Y ou can update authorization keys automatically with the xp.cnf file (and the
authkey.dat file), or you can open the Authorization Key Manager client. The
client provides a user interface where you can enter and del ete authorization
key and network computer information before updating the authorization keys.

Updating the Authorization Key When Booting

To automatically update authorization keys when booting, edit the xp.cnf file to
uncomment the update_authkey command. The network computer reads the
authkey.dat file when booting and updates the network computer and
authorization key information. (Be sure that SNMP is available and enabled.)

Starting the Authorization Key Manager Client with xpsh

Usexpsh to open the Authorization Key Manager client asshownin Figure4-1.
Theclient’s interface allows you to add and delete information from the
authkey.dat file, and to force the authkey.dat file to be read without having to
reboot the network computer.
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To start the client with xpsh, enter this command:
xpsh authkey

Using the Authorization Key Manager Client

The Authorization Key Manager client can be started only with xpsh. When it
starts, the window shown in Figure 4-2 appears.

Authorization Key Manager

NComputer List

Ethernet Authorization Key IP Address Status
08:00:34:94:33:EJ JAB(4%>3+[=T;fjqc None
08:46:22:69:47:32 AK)&AMB@.?JTOR&|\ None
08:42:90:00:31:69 Jk%3+=]klw\jvv<?! None
08:47:35:69:21:21 Uu$rgvuli#=/>1GLq None

Ethernet Address Authorization Key
| | | | [ AddEntry | [ Delete Entry|

Update Edit Save
Authkey Broadcast List Authkey File

Exit

Figure 4-2 Authorization Key Manager Window
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The Authorization Key Manager window shows the ethernet addresses and
authorization keys as listed in the authkey.dat file. Before updating
authorization keys, you can add and delete information in this window. This
information isread in addition to the entries in the authkey.dat file. The
following topics are discussed:

» Adding and Deleting Network Computer Information
 Editing the Broadcast List

» Updating Authorization Keys

 Saving the authkey.dat File

Adding and Deleting Network Computer Information

The Authorization Key Manager window contains network computer
information necessary for updating authorization keys. If you have information
in the authkey.dat file, it displaysin this window.

» Todedete an entry, select the information to delete with the mouse and it
prefillsin the Ether net Addressand Authorization K ey fields. Then select
Delete Entry.

» Toaddanentry, enter itsethernet addressinthe Ethernet Addressfield, and
its new authorization key in the Authorization Key field and select Add
Entry.

To apply your changesto the authkey.dat file, refer to Saving the Authkey File.

Editing the Broadcast List

The Authorization Key Manager searches the specified broadcast address for
those network computers that match the ethernet addresses listed in the
authkey.dat file. To view and or edit the broadcast list, select the Edit
Broadcast List button. The window shown in Figure 4-3 appears.
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Authorization Key Manager

Broadcast List

144.67.33.255

Broadcast Address

Return to

Add Entry Delete Entry Main Menu

Figure 4-3 Edit Broadcast List Window

Thiswindow lists the broadcast addresses that the Authorization Key Manager
client searches when updating authorization keys. Y ou can add and delete
information in this window. Information in this window isread in addition to
the entries in the authkey.dat file.

» Toadd abroadcast address, enter the addressin the Broadcast Addressfield
and select Add Entry.

* To delete an address, select the address to delete with the mouse, and then
select Delete Entry.

To apply your changesto the authkey.dat file, refer to Saving the Authkey File.
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Updating Authorization Keys

When the correct information isin the Authorization Key Manager window,
select the Update Authkey button. The authorization keys are updated for
those network computers listed.

The update status for each network computer is displayed as either Successful
or Unreachable. If the statusis Unreachable, check that you entered the correct
ethernet and authorization key information. Make sure also that you have
SNMP enabled.

Saving the Authkey File

After making changes to the ethernet addresses, authorization key, or broadcast
information, you can save those changes to the authkey.dat file. To save
changes, select Save Authkey File. The window shown in Figure 4-4 appears.

Authorization Key Manager
Save Authorization Key File
AccessMethod | TFTP | [ NFS |
Host | |
File Name | |
Save Return to
Authkey File Main Menu

Figure 4-4 Save Authkey File Window
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1. Select the access method for saving theinformation to thefile: NFSor TFTP.

Note: If you use TFTP asthe access method, the file authkey.dat
must already exist and have world write permissions.
2. Enter the host name on which the authkey.dat file is located.
3. Enter the path and file name to which the information is to be saved.

4. Select the Save Authkey File button to save the information in the
Authorization Key Manager client to the authkey.dat file.

5. Select Return to Main Menu to exit the Save Authkey File window.
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Touchscreen Calibration Client

The Trident Touchscreen Calibration Client enables you to calibrate the
touchscreen. The Calibration Client is shown in Figure 4-5.

Calibrate

Up Threshold: 4 Down Threshold: 1
[ | [T |

Jitter Control: 4 OutOfBounds Data: 0
{1}

[
Normal Mode

Figure 4-5 Calibration Client

To invoke the Calibration Client, first map it to a keysym using the
keysym action_entry command. For example, to invoke the client with the F1
key, enter the following in the xp.cnf file:

keysym_action_entry =~ F1  TOUCH CALIBRATE ALL

Touchscreen jitter can be controlled with the touchSc_Jitter command:
touchSc_Jitter 4 # touch screen jitter control

Inthisexample, the 4 indicatesthat achange of lessthan 5 pixelswhen touching
the screen does not cause the cursor to move.

The Calibration Client includes the following elements:

Note: Not all elementsare available on all touchscreen devices.
Only those elements needed for your touchscreen appear.

Up Threshold controls the touch up threshold

Down Threshold controls the touch down threshold

Jitter Control controls the jitter and SAW touchscreen pressure threshold
OutOfBounds Data controls the out of bounds data
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Normal M ode controls the different touch modes. The available modes are:

- Norma Mode: user touching the screen generates a button press; user

dragging his finger generates a button press motion (like pressing the
mouse button and dragging the mouse), user lifting hisfinger generates a
button release event.

Point Mode: user touching the screen generates a button press and release
event immediately.

Tap Mode: allows the touchscreen to operate like a mouse. The user
touching the screen generates amotion event allowing the user to drag the
cursor around the screen (like moving the mouse). Lifting hisfinger from
the screen and touching the screen again within a predefined time limit
(about 1/4 second) causes a button press event (like pressing a mouse
button). The user can now move his finger around the screen causing
button press motion events (like pressing the mouse button and moving
the mouse simultaneously). Removing his finger from the screen
generates a button rel ease event (like rel easing the mouse button).

Release Mode: creates motion events as the user touches the screen and
drags hisfinger. When the user removes hisfinger, abutton pressevent is
generated, followed immediately by a button release event.
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Window Managers
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This chapter describes the local window managers available on the network
computer. These window managers are: Motif Window Manager (MWM) and
XP Window Manager (XPWM).

Setting Up Local MWM

Starting local Motif Window Manager (MWM) from your host allows MWM to
access the configuration and resource files in a standard location, for example,
the %o HOMEDRIVE%%HOMEPATH% directory. It also allows you to
customize the window manager menus and to define menu selections that
include host commands. For detailed information about MWM configuration,
refer to the MWM man pagelocated in the C:\NCBridge\tekxp\man\nt directory
by default.
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Starting Local MWM

Enter the following command in the user’s session start up file.
xpsh -display displayname: 0.0 mwm
This assumes that xpsh isin your search path. The default search path is/tekxp/

bin/<host>. Y ou need not specify -display displayname:0.0if you have set the
DISPLAY environment variable.

Note: You can also start local MWM using the remote
configuration file or the Client Launcher. However, these
methods do not allow MWM access to the system-level and
user-level customization files on your host.

Starting MWM with the xp.cnf File

The start and preload commands in the xp.cnf file can be used to start MWM.
For detail s about these commands, refer to Chapter 2, Remote Configuration in
the NCBridge Reference Manual.

Starting MWM with the Client Launcher

Y ou can customize the Client Launcher to include those clients that you use
most often. If authorized, MWM islisted on the Client Launcher by default as
part of the Window Managers submenu. To start MWM, move the mouse
pointer to MWM and click the mouse button. For information about the Client
Launcher, refer to the Client Launcher section in Chapter 4, Local Clients.

Accessing MWM Configuration Files

When gtarting local MWM using xpsh, using the -access xpsh command-line
option enables local MWM to access full resource and file access asif it were
started from a host. For example, the following line starts local MWM and
accesses system-level and user-level customization files on the host:

xpsh -access xpsh mwm
Accessing the MWM Resource Description File
MWM searches for aresource description file in this order:
1. Thevalue of the MWM configFile resource
2. %HOMEDRIVE%%HOMEPATHY/.mwmrc
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3. lusr/lib/X11/system.mwmrc
4, Jusr/lib/X11/system.mwmrc

If MWM does not find aresource description file in one of the above locations,
it defaults to a language-specific defaults file under the boot directory,
typically, C:\NCBridge\tekxp\boot\< |language>\system.mwmrc. The
<language> variable is determined by the language command in the remote
configuration file, or in Setup. To see the current language setting, enter Setup
and look at the L anguage option. A sample system.mwmrc file islocated in
\tekxp\exampl es\mwm.

Creating a Local MWM Resource Description File

Y ou can copy the system.mwmrc file to your home directory and then modify
the file to customize your Motif environment. Table 5-1 shows the functions
you can add to thefile.

Table 5-1 MWM Functions

Function Description

f.beep Causes a beep.

f.cci Controls the placement and naming of client-command interface (CCI)
commands generated by applications.

f.circle_down Moves the top window to the bottom of the window stack.

f.circle_up Moves the bottom window to the top of the window stack.

f.exec or! Executes the following shell command.

f.focus color

Sets the colormap focus to a window.

f.focus_key Sets the keyboard input focus to a window.

f.goto Moves the root window to a specified location.

fkill Kills an application and its window.

f.lower Moves awindow to the bottom of the window stack.

f.maximize Maximizes awindow.

f.menu Activates the named menu. This function can be used to create cascading
and Popup Menus.

f.minimize Iconifies awindow.
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Table 5-1 MWM Functions (continued)

Function Description

f.move Starts an interactive move for awindow.

f.next_cmap Installs the next colormap.

f.next_key Moves the keyboard input focus to the next window in the window stack.
f.nop Does nothing.

f.normalize Causes an icon or amaximized window to be displayed at its normal size.

f.normalize_and_raise

Causes an icon or a maximized window to be displayed at its normal size
and raised to the top of the window stack.

f.pack_icons Reorganizes the icons according to the current icon placement palicy.
f.pan Moves the root window a specified amount.
f.pass_keys Toggles the use of special key bindings.

f.post_wmenu

Posts the Window Menu.

f.prev_cmap Installs the previous colormap in thelist of colormapsfor the window with
the colormap focus.

f.prev_key Moves the keyboard input focus to the previous window in the window
stack.

f.quit_mwm Exits the window manager without exiting the X Window System.

frraise Rai ses awindow to the top of the window stack.

f.raise_lower If obscured, raises awindow to the top of the window stack; otherwise,
lowers it to the bottom of the window stack.

f.refresh Redraws all the windows on the screen.

f.refresh_win Redraws a single window.

f.resize Starts an interactive resize for awindow.

f.restart Stops and restarts the window manager.

f.restore Restores an iconified window to its previous state.

f.restore_and_raise

Restores an iconified window to its previous state and raises it to the top
of its stack.

f.screen

Moves a pointer to a specific screen.

f.send_msg

Sends a client message to the application.
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Table 5-1 MWM Functions (continued)

Function Description

f.separator Draws a separator in a menu pane.

f.set_behavior Restarts the window manager with the default behavior or revertsto any
custom behavior.

f.title Inserts atitlein amenu pane.

f.track_pan Continuously moves the root window in the direction of the mouse.
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Accessing the MWM Defaults File

MWM is configured from its resource database. This database is built from the
following sources, listed in the order that MWM accesses them.

1.
2.

MWM command-line options.

File specified by the XENVIRONMENT environment variable, if it is s,
otherwise:
%HOMEDRIVE%%HOMEPATHY%/. Xdefaults-terminal_name, if it exists.

These values do not override the existing values in the database.

. RESOURCE_MANAGER root window property, if it is set, otherwise:

%HOMEDRIVE%%HOMEPATH%/. Xdefaults, if it exists.

The RESOURCE_MANAGER istypically set with the xrdb command.
These values do not override the existing val uesin the database. An example
Xdefaults file is shown in Example 5-1.

. The user’s application specific app-defaultsfile:

%HOMEDRIVE%%HOMEPATH%/Mwm, if it exists, otherwise:
%HOMEDRIVE%%HOMEPATHY/Mwm

The actual location of thisfile depends on the XUSERFILESEARCHPATH
and XAPPLRESDIR environmental variables. These values do not override
the existing values in the database.

. The application’ s specific app-defaults file:

Jusr/lib/X11/app-defaults/Mwm, if it exists, otherwise:
usr/lib/X11/app-defaultsMwm

The actual location of this file depends on the XFILESEARCHPATH
environmental variable. These values do not override the existing valuesin
the database.

If none of the above application specific app-defaultsfilesare found, MWM
defaults to alanguage-specific defaults file from the boot configuration
directory, typically, /tekxp/boot. The language is specified by the L anguage
command in the remote configuration file (xp.cnf), or in Setup. To see the
current language setting, enter Setup and look at the L anguage option.
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Example 5-1 Example .Xdefaults File

! For the monochrome

(or 4 bit plane=16 color/grey)

Accessing the MWM Defaults File

device,

! decorations are shaded with pixmaps.The window title 1is
! reverse video to improve visibility.

#if PLANES > 4
Mwm*menu*background
Mwm*menu*foreground:
Mwm*background:

Mwm* foreground:
Mwm*activeForeground:
Mwm*activeBackground:

#else

Mwm*bitmapDirectory:
Mwm*bottomShadowColor:

Mwm* topShadowColor:
Mwm*activeBottomShadowColor:
Mwm*activeTopShadowColor:
Mwm*background:
Mwm*client*backgroundPixmap:
Mwm*activeBackground:
Mwm*activeBackgroundPixmap:
Mwm* foreground:
Mwm*client*foregroundPixmap:
Mwm*activeForeground:
Mwm*activeForegroundPixmap:
Mwm* iconImageBackground:
Mwm* iconImageForeground:
Mwm* iconImageBottomShadowPixmap :
Mwm* iconImageTopShadowPixmap :
#endif

Mwm*buttonBindings:
Mwm*clientDecoration:
Mwm*clientAutoPlace:

Mwm* frameBorderWidth:
Mwm*iconAutoPlace:
Mwm*iconClick:

Mwm* iconBoxGeometry:

Mwm* iconDecoration:
Mwm*iconFrameBorderWidth:
Mwm*iconPlacement :
Mwm*iconPlacementMargin:
Mwm*interactivePlacement:
Mwm*keyBindings:
Mwm*passSelectButton:
Mwm*resizeBorderWidth:

Mwm* showFeedback:

Mwm* systemButtonClick:
Mwm*systemMenu:
Mwm*useIconBox:
Mwm*windowMenu:
Mwm*cleanText :

Mwm* saveUnder :
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DefaultButtonBindings
all
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True

False

6x1+0-0
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False
DefaultKeyBindings
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False
DefaultRootMenu
True
DefaultWindowMenu
True
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Chapter 5 Window Managers

Accessing Bitmap Files

The MWM iconlmage and bitmapDirectory resources are used to specify paths
to bitmap files. The default value for bitmapDirectory is the /usr/include/X11/
bitmaps directory. To access a bitmap file star in your
%HOMEDRIVE%%HOMEPATH% directory, the iconlmage resource can be
set in your %HOMEDRIVE%%HOMEPATH%/. Xdefaults file as follows:

Mwm* program_name*iconl mage: ~/star

Specifying Virtual Key Bindings

MWM reads the %0HOMEDRIVE%%HOMEPATH%/.motifbind file, if it
exists, to install avirtual key bindings property on the root window. Example
motif bindings files are installed in the /tekxp/examples/mwm directory by
default.

Setting Up Virtual Desktop Panning

The Virtual Desktop Panning feature is available with MWM 2.0. This section
provides an example of how you can modify your .Xdefaults and .mwmrc files
to activate virtual panning in MWM. The MWM functions f.pan, f.goto, and
f.track_pan need to be bound either to keys or to mouse buttons.

Editing the .mwmrc File for Virtual Desktop Panning

Add the following to your .mwmrc file to use virtual panning. Make sure that
the name of the button bindings match the name given for the resource value
Mwm?* buttonBindings in your .Xdefaults file.

Buttons MyButtonBindings

<Btn2Down> root f.menu GotoMenu
Meta<BtnlDowns> root f.track pan

Keys MyKeyBindings

Meta<Key>Up window | root f.pan 0,-100
Meta<Key>Down window | root f.pan 0,100
Meta<Keys>Left window | root f.pan -100,0
Meta<Key>Right  window|root f.pan 100,0

}
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Setting Up Virtual Desktop Panning

To set upamenu that letsyou quickly switch to different locations on the virtual
desktop, enter the following. Then restart MWM.

Menu GotoMenu
{

Up-Left f.goto
Up f.goto
Up-Right f.goto
Left f.goto
Home f.goto
Right f.goto
Down-Left f.goto
Down f.goto
Down-Right f.goto

}

1500,1100
0,1100
-1500,1100
1500,0

0,0

-1500,0
1500, -1100
0,-1100
-1500,-1100

Editing the .Xdefaults File for Virtual Desktop Panning

Add the following to your .Xdefaults file to keep MWM from moving all your
windows back to the visible part of the screen at startup:

Mwm*positionOnScreen:

False

Note that it isimportant to set the positionOnScreen resource to False because
MWM automatically repositions all off-screen windows back to the display

screen on restart.

To set up amenu to go to preset positions on the virtual canvas, add the

following lines:

Mwm*GotoMenu*numColumns:
Mwm*GotoMenu*packing:
Mwm*GotoMenu*orientation:
Mwm*GotoMenu*alignment :

3

PACK COLUMN
HORIZONTAL
ALIGNMENT CENTER

For consistency with the .mwmrc file, add the following lines:

Mwm*buttonBindings:
Mwm*keyBindings:

MyButtonBindings
MyKeyBindings

To prevent the client and icon windows from moving, add the following lines:

Mwm*XBiff*iconPinned:
Mwm*XBiff*clientPinned:
Mwm*iconPinned:

True
True
True
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Chapter 5

Window Managers

Troubleshooting MWM

5-10

This section contains some information on possible solutions to correct some
common MWM problems:

e If MWM does not come up at all:

- You did not specify the NC name correctly in the -display command line
option. Recheck the value, for example:

xpsh -display displayname: 0.0 xpwm

- Your local MWM authorization key may not be entered. To check your
enabled options, press Setup. Drag on Statistics and rel ease on Options. If
mwm is not there, enter the correct authorization key at the Boot Monitor.
Refer to Chapter 4, Boot Monitor of the NCBridge Reference Manual.

- If youstart MWM with xpsh and it fail sto execute clientsfrom the MWM
menus, make sure that the path to the client is correct.

- Check the console window for a message indicating that there is not
enough memory to run MWM. Increase the amount of available memory
if necessary.

 If you customize afilewhichisread by local MWM but the changes are not
reflected when you run MWM:

- Make sure the customized file has world read permissions.

« If your keyboard has neither a Meta key nor an Alt key, use the xmodmap
command to display and modify the values of mapped keys, including the
key mapped to mod1, which MWM uses for Meta or Alt.
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Setting Up XP Window Manager

Setting Up XP Window Manager

XP Window Manager (XPWM) is alocal window manager available with the
network computer. XPWM provides a basic window manager that uses a
minimum amount of network computer memory.

Accessing the XPWM Defaults File

XPWM isconfigured from itsresource database. Thisdatabaseis built from the
following sources, listed in the order that XPWM accessesthem (thelast setting
takes precedence over the first).

1. RESOURCE_MANAGER root window property, if it is set.

The RESOURCE_MANAGER istypically set with the xrdb command.
These values do not override the existing values in the database.

2. The application’s specific app-defaultsfile:
fusr/lib/X11/<language>/app-defaul ts/xpwm
3. XPWM default values.

Starting the XP Window Manager
XPWM can be started with xpsh, from the remote configuration file (xp.cnf),
or from the Client Launcher.
Starting XPWM with xpsh
Enter the following command in the user’s session start-up file.
xpsh -display displayname: 0.0 xpwm

This assumesthat xpsh isin your search path. The default search path is/tekxp/
bin/<host>.

Note: You need not specify -display displayname: 0.0 if you have set
the DISPLAY environment variable.

Starting XPWM with the xp.cnf File

The start and preload commandsin the xp.cnf file can be used to start XPWM.
For details about these commands, refer to Chapter 2, Remote Configuration, in
the NCBridge Reference Manual.
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Chapter 5 Window Managers

Starting XPWM with the Client Launcher

The Client Launcher can be customized to include those clients that you use
most often. The XPWM is listed on the Client Launcher by default as part of
the Window Managers submenu. To start XPWM, move the mouse pointer to
XPWM and click the mouse button. For information about the Client Launcher,
refer to the Client Launcher topic in Chapter 4, Local Clients.

Using XPWM

Y ou use XPWM much like any other window manager. The windows have
many of the same elements asthe Motif Window Manager. Figure 5-1 shows a
sample XPWM window and its elements.

Window Name Title Bar Resize Button
Iconify [ ¢ ¢ 7]
Button ~ | X | xterm |

eagle>

Scroll Bar — Window with

Input Focus

X —~—|con

xterm

8049-144

Figure 5-1 Elements of an XPWM Window
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Using XPWM

Y ou can move and resize windows using either the mouse alone, or the
commands | ocated on the XPWM menu. Table 5-2 shows the mouse interface.

Table 5-2 Working With XPWM Windows

To

Do This

Move a window

Position the mouse pointer on thetitle bar, click and drag
the window to the new position.

Resize a window

Click on the Resi ze button and drag the window to the new
size.

Make awindow active Position the mouse pointer on thetitle bar and click.

| conify awindow

Click on the Iconify button.

De-iconify awindow Click on the window’s icon.

Raise awindow to the top | Position the mouse pointer in the window and click.

To access the XPWM menu, position the mouse pointer outside of a window,
and click. First select acommand, and then move the mouse pointer to the
window you want the command to affect. Table 5-3 shows the commands
available on the XPWM menu.

Table 5-3 XPWM Menu Commands

Command Description

| conify Iconify awindow.

Resize Resize awindow.

Move Move awindow.

Raise Move awindow to the top of other windows.

Lower Move awindow behind other windows.

Icon Manager Open the icon manager, which lists the open windows and
applications on the screen.

Kill Close awindow and any processes running in the window.

Delete Close a secondary window, such as adiaog box for an application.

Restart XPWM Exit and restart the X pressWare Window M anager. Open windows
and processes will remain while the window manager restarts.

Exit XPWM Exit the X pressware Window Manager.
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Customizing XPWM

Y ou can change the appearance of XPWM using the resource settingslisted in
Table5-4. XPWM does not allow user-defined bindings or user-defined menus.

Table 5-4 XPWM Resource Settings

5-14

Resource

Description

xpwm.l conForeground <color>

Specifies foreground color of icons.

xpwm.lconBackground <color>

Specifies background color of icons.

xpwm.lconFont <font>

Specifies the font used with icon names.

xpwm.TitleForeground <color>

Specifies the foreground color of the title bar.

xpwm.TitleBackground <color>

Specifies the background color of thetitle bar.

xpwm.TitleFont <font>

Specifies the font used in the title bar.

xpwm.M enuForeground <color>

Specifies the foreground color of the XPWM menu.

xpwm.MenuBackground <color>

Specifies the background color of the XPWM menu.

xpwm.MenuFont <font>

Specifies the font used in the XPWM menu.

xpwm.BorderWidth <integer>

Specifies the width of the border around the windows.

xpwm.BorderColor <color>

Specifies the color of the borders around the windows.

xpwm.BorderHighlightColor <color>

Specifies the border highlight color.

xpwm.|conPosition <position>

Specifies the icon position.

xpwm.| nteractivePlacement <state>

Specifies whether placement isinteractive or static (true/
fase).

xpwm.InputFocus <method>

Specifies the method used by the mouse to activate a
window. Enter either click or point.
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Chapter 6

Using Fonts

This chapter describes how to set up fonts on the host to support entries added
in the remote configuration file and the fonts.tbl file. The network computers
use PCF format as standard, but can read SNF, SCF, SNF.Z, PCF, PCF.Z,
PCFz, BDF, DECW$FONT, and many compressed formats.

The font access method is specified in the remote configuration file. The
network computer can accessfontsviaTFTP, NFS, or DAP. Font filestend to
be large; they do not have to be installed on the same disk as the boot files.

If you use NFS as the file access method, the fonts can be placed anywhere in
the host file system, with NFS directories and exports set accordingly. Use an
nfs_table command or add an nfs.tbl entry, and enable NFS access.
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Chapter 6 Using Fonts

How the X Server Builds the Font Database

At boot time, the X server builds afont database based on the following
sequence of events:

1. The X server searches the primary path for afonts.thl file.

If afonts.tbl fileisnot found with the primary path, the X server searchesthe
secondary path for afonts.thl file. The secondary path is used if the primary
path is not specified. Primary and secondary paths are specified in either the
remote configuration file or in Setup. If fonts are not found through the
primary or secondary paths, the X server searchesthe boot host and the boot
method.

In this example, the primary file path for the configuration filesis
\tekxp\boot\fonts on the host arizona, accessed with NFS. The
file_host_name is not needed for NFS, but is specified as a null string to
ensure a correct path.

ip host table "128.07.60.12" "arizona"
file access_1 NFS

file host name 1 ""

file path 1 "/tekxp/boot/fonts"

In this example, the secondary file path for the configuration filesis
\usr\tekxp\boot\fonts, where \usr\tekxp\boot\fonts is an exported directory
from the host oregon and accessed through NFS. The file_host_nameis not
needed for NFS, but is specified as a null string to ensure a correct path.

file access 2 NFS
file host _name 2 ""
file path 2 "/usr/tekxp/boot/fonts"

This example assumes that you have an entry similar to the following in the
nfs.tbl file:

arizona: /tekxp/boot/fonts /tekxp/boot/fonts
oregon:/usr/tekxp/boot/fonts/usr/tekxp/boot/fonts
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How the X Server Builds the Font Database

2. When the X server finds afonts.thl file, it searches the directories listed in
thisfile for fonts.dir and fonts.alias files. The X server uses the information
in the fonts.dir and fonts.alias files to search for specific font files. The X
server rejects the path unless it finds both fonts.dir and fonts.alias files.

Note: Oncethefonts.thl fileisfound, the X server ignores
file_path_1 and file_path_2 when searching for specific font
files.

The fonts.dir file maps file namesto an X logical font descriptive name
(XLFD); thefonts.aliasfilelists alternative namesfor the XL FD font names.
A typical entry for fonts.dir is:

5x8.snf -misc-fixed-medium-r-normal--8-80-75-75-c-50-
iso8859-1

Typical entries for fonts.alias are:

FILE NAMES ALIASES
5x8 -misc-fixed-medium-r-normal--8-80-75-75-c-50-1is08859-1

3. The network computer resolves font paths in this order:
a Primary access and font path.
b. Secondary access and font path.

¢. Boot host and boot method.

Accesscan beahostif usng TFTP or DAP asthe access method, or amount
point if using NFS. If not resolved, the font path is rejected.

4. Resident fonts are always available unless explicitly removed with the
xset fp- command. Refer to Table 6-1 for the list of resident fonts.

Note: xsetislocated in \NCBridge\tekxp\bin\nt\xset.
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Chapter 6 Using Fonts

Resident and Boot Directory Fonts

Resident fonts, listed in Table 6-1, are loaded with the X server, and are always
available unless preceded by afonts.dir or fonts.alias file entry. Boot directory
fonts, listed in Table 6-2, are loaded from the installation mediainto the directory

\tekxp\boot.

Table 6-1 Resident Fonts

Font X Logical Font Description Name (XLFD)

TekDefault -adobe-helvetica-bol d-r-normal--14-140-75-75-P-82-is08859- 1
LucidaV2RT10 -bigelow & hol mes-lucidav2-medium-r-normal-typewriter-16-100-100-100-
(TekFixed) m-80-is08859-1

cursor (TekCursor)

cursor

Table 6-2 Boot Directory Fonts

Font X Logical Font Description Name (XLFD)

6x13 -misc-fixed-medium-r-semi condensed-- 13- 120-75-75-c-60-i s08859-1

6x10 -misc-fixed-medium-r-normal --10-100-75-75-c-60-i s08859- 1

6x13B -misc-fixed-bol d-r-semi condensed-- 13-120-75-75-c-60-is08859- 1

tdwht132 tekdwht132

8x13 -misc-fixed-medium-r-normal --13-120-75-75-c-80-is08859- 1

9x15 -misc-fixed-medium-r-normal --15-140-75-75-c-90-i s08859- 1

8x13B -misc-fixed-bold-r-normal --13-120-75-75-c-80-is08859-1

9x15B -misc-fixed-bold-r-normal -- 15-140-75-75-c-90-is08859-1

tdwhb132 tekdwhb132

decsess decw$session

tdwdhb80 tekdwdhb80

Luv2RT12 -bigelow & holmes-lucidav2-medium-r-normal -typewriter-21-120-100-100-
m-100-is08859-1

LuvV2RT14 -bigelow & holmes-lucidav2-medium-r-normal -typewriter-22-140-100-100-
m-120-is08859-1

olcursor -sun-open look cursor-----12-120-75-75-p-160-sunol cursor- 1
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Resident and Boot Directory Fonts

Table 6-2 Boot Directory Fonts (continued)

Font X Logical Font Description Name (XLFD)

luRS12 -bé& h-lucida-medium-r-normal-sans-12-120-75-75-p-71-is08859- 1

tdwdht80 tekdwdht80

LuciB10 -bigelow & holmes-lucida-bold-r-normal -serif-14-100-100-100-p-97-
is02022_r_tek-1442r433

7x13euroB -misc-fixed-bold-r-normal --13-120-75-75-c-70-fcd8859-15

techB14 -bitstream-terminal -bol d-r-normal -- 18- 140-100-100-c-110-dec-dectech

tekdw80 tekdw80

fg-22 fg-22

ibm2412 ibm2412

ibm2413 ibm2413

ibm1307 ibm1307

ibm1108 ibm1108

ibm1205 ibm1205

ibm1313 ibm1313

ibm2510 ibm2510

ibm1207 ibm1207

ibm1104 ibm1104

ibm2612 ibm2612

ibm1209 ibm1209

deccurs decw$cursor

ibm2508 ibm2508

ibm1006 ibm1006

ibm1111 ibm1111

Luv2NT12 -bigelow & holmes-lucidav2-medium-r-condensed-ty pewriter-21-120-100-
100-m-100-is08859-1

ibm0504 ibm0504

ibm1408 ibm1408

ibm2116 ibm2116

ibm0505 ibm0505

ibm2011 ibm2011
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Table 6-2 Boot Directory Fonts (continued)

Font X Logical Font Description Name (XLFD)
ibm0404 ibm0404

ibm1508 ibm1508

ibm1616 ibm1616

ibm0502 ibm0502

ibm1608 ibm1608

ibm1609 ibm1609

luBS14 -b& h-luci da-bold-r-normal -sans-14-140-75-75-p-92-is08859-1
ibm0707 ibm0707

ibm0604 ibm0604

ibm2108 ibm2108

luBS12 -b& h-luci da-bold-r-normal -sans-12-120-75-75-p-79-is08859-1
ibm0605 ibm0605

ibm0606 ibm0606

ibm1406 ibm1406

ibm0703 ibm0703

ibm1511 ibm1511

ibm0904 ibm0904

ibm0907 ibm0907

ibm0805 ibm0805

ibm0806 ibm0806

ibm0808 ibm0808

ibm1813 ibm1813

ibm0909 ibm0909

ibm1807 ibm1807

ibm2816 ibm2816

olgl12 -sun-open look glyph-----12-120-75-75-p-113-sunolglyph-1
tis1212 tis1212

tis2412 tis2412

tis2424 tis2424

tisA812 tisA812
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Resident and Boot Directory Fonts

Table 6-2 Boot Directory Fonts (continued)

Font X Logical Font Description Name (XLFD)
tisA824 tisA824
tis1210 tis1210
tis2410 tis2410
tis1203 tis1203
tis2416 tis2416
tisA816 tisA816
tis1205 tis1205
tis2405 tis2405
tis1206 tis1206
tis2406 tis2406
tis2414 tis2414
tisA814 tisA814
tis2407 tis2407
tisA807 tisA807
tis2408 tis2408
tisA808 tisA808
tis1408 tis1408
tis2012 tis2012
tis1610 tis1610
tis2010 tis2010
tis3210 tis3210
tis1616 tis1616
tis2020 tis2020
tis3216 tis3216
tis1605 tis1605
tis3205 tis3205
tis2006 tis2006
tis1608 tis1608
tis3208 tis3208
tis1410 tis1410
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Table 6-2 Boot Directory Fonts (continued)

Font X Logical Font Description Name (XLFD)

tis1404 tis1404

tis1416 tis1416

tis1405 tis1405

tisl414 tisl414

tis1407 tis1407

tis4012 tis4012

LuciRT10 -bigelow & holmes-luci da-medium-r-normal-typewriter-16-100-100-100-m-
80-is02022_r_tek-1442r433

tis4010 tis4010

tis4020 tis4020

tis4006 tisA006

tis2810 tis2810

tis2816 tis2816

tis2805 tis2805

tis2814 tis2814

tisc614 tisc614

tis2807 tis2807

tis2808 tis2808

tis2828 tis2828

tis6628 tis6628

tm14_100 -bitstream-terminal-medium-r-normal-- 18-140-100-100-c-110-is08859- 1

timR24 -adobe-times-medium-r-normal--24-240-75-75-p-124-is08859- 1

timR10 -adobe-times-medium-r-normal--10-100-75-75-p-54-is08859- 1

helvB12 -adobe-helveti ca-bold-r-normal --12-120-75-75-p-70-is08859- 1

tktrm132 tktrm132

LuciBT10 -bigelow & holmes-lucida-bold-r-normal -typewriter-16-100-100-100-m-80-
is02022_r_tek-1442r433

7x13euro -misc-fixed-medium-r-normal--13-120-75-75-c-70-fcd8859-15

tis704 tis704

tis603 tis603

6-8 NCBridge for Windows NT Installation and Configuration Manual



Font Server Information

Table 6-2 Boot Directory Fonts (continued)

Font X Logical Font Description Name (XLFD)

tis606 tis606

tis708 tis708

tml4 75 -dec-terminal-medium-r-normal --14-140-75-75-c-80-is08859- 1
tis810 tis810

tis805 tisB05

tekdw132 tekdw132

Font Server Information

Refer to Chapter 11, Using Fonts, in the NCBridge for Unix Installation
Manual for font server information.
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Installing Fonts

The installation media provides fonts.dir files for each font directory listed in
Table 6-3, although you may have to add the names of these directoriesto the
fonts.thl file. To install additional PCF, SCF, SNF or other directly supported
fonts:

1. Make adirectory for your font files, for example, myfonts.
2. Copy the additional fontsin the myfonts directory.

3. If the fonts are compressed (ending in .Z), you can uncompress them for
faster reading, or leave them compressed to save disk space. To use
uNcompr ess:

# uncompress *

Note: You must perform the uncompress command on a Unix host
and copy thefiles to the Windows NT host.

4. Run mkfontdir to create afonts.dir file. Enter:
# mkfontdir myfonts
Note: mkfontdir isfound in the C:\NCBridge\bin\nt directory.

5. Use an editor to create the fonts.aliasfile. Y ou can include the keyword
FILE_NAMES_ALIASES to indicate you are mapping the file name to the
alias. Add the aliases and the font logical names to the file.

Note: Thefonts.aliasfile should exist, even if it is empty.

Refer to the mkfontdir man pagein the C:\NCBridge\tekxp\man\nt directory
for more information.

6. Edit \tekxp\boot\fonts\fonts.tbl and add the new font path.
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Installing Fonts

Table 6-3 lists the font directoriesin the \tekxp\boot\fonts directory.

Table 6-3 Font Directories Available on the Installation Media

Directory Source, Contents, Application

misc Cursor and character fonts, MIT miscellaneous fonts.

100dpi X Consortium distribution for 100 dot-per-inch fonts. Some fonts contain
eight-bit multinational character sets.

75dpi X Consortium distribution for 75 dot-per-inch fonts. Some fonts contain
eight-bit multinational character sets.

tek100dpi Tektronix-distributed Lucida fonts.

oldx11 X Consortium distribution fonts, including fonts released prior to X
Version 11, Release 3.

openl ook OPEN LOOK applications fonts.

japanese Japanese fonts.

Speedo Speedo fonts from Bitstream, Inc.

Typel Courier (typewriter) font from IBM Corporation.
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Chapter 7

Troubleshooting

This chapter contains information to help solve problems when booting and
using your network computer. Table 7-1 lists identified problems and the page

numbers to locate possible solutions.

Table 7-1 Possible Problems

Problem Page
Boot host does not respond 7-2
Network computer does not respond to a ping 7-3
Duplicate IP address message 7-3
Network computer cannot locate osfile 7-3
Network computer cannot locate .tbl files 7-4
Network computer cannot locate font files 7-4
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Chapter 7 Troubleshooting

7-2

Boot host does not respond
» Verify that the boot host is configured to support the boot method you

selected. Supporting host files may include inetd.conf, bootptab, exports,
hosts, and ethers.

Under Control Panel > Services, make surethe TFTPD serviceis started.

If you are booting from NVRAM , use the network computer Boot Monitor
to verify that the correct values are assigned for the following commands:

- Network computer |P address (iaddr) or node number (dnode)
- Boot host |P address (ihost)

- Subnet mask (imask)

- Gateway address (igate)

- Boot method (bmethod)

- Boot path (bpath)

- Boot from (bafrom set to NVRAM)

If you are booting from NETW ORK, use the network computer Boot
Monitor to verify the correct values are assigned for the following
commands:

- Boot method (bmethod)
- Boot from (bafrom set to NETWORK)

Use the network computer Boot Monitor to ping the boot host. If the host
does not respond, use the ifconfig command on the host to verify the host’s
subnet mask and gateway address. The ifconfig command is a so used to
change the subnet mask and gateway addressif necessary.

If the host has an ethernet switch, make sure it is set to the proper position
for thicknet or thinnet.
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Network computer does not respond to a ping

Network computer does not respond to a ping
* Verify that the network computer is booted.

» Usethe network computer Boot Monitor report command to check the
network computer’s ethernet switch or jumper setting. If itisincorrect, refer
tothe pictorial physical installation guide for your network computer model.

Duplicate | P address message

This can indicate two different problems: either there are two devices using the
same | P address, or there is amismatch between the ethernet and | P addresses
in the host files or in the router ARP tables.

* Todetermine if there are two devices using the same |P address, goto a
different device and ping the duplicate IP address. If two responses come
back, change the IP address on one of the devices. Be sure to save the new
address. You may also have to change supporting files on the host, such as
%SYSTEMDRIVE%%SYSTEMROOT%0\system32\drivers\etc\hosts and
change entriesin the ARP table (arp command) to ensure the correct
ethernet and I P addresses are used.

* If the network computer is using the same I P address as a previous device
(that has been removed from the network), then the problem is a mismatch
between the ethernet and |1P addresses. To correct this situation, change the
fileswhere the ethernet and | P addresses are used and change entries in the
ARPtable (ar p command). The network administrator should flush the ARP
table in the router.

Network computer cannot locate osfile

» Verify that the boot path is specified correctly and matches the actual file
location on boot host. If using secure tftp, the secure directory should not be
specified as part of the boot path.

» Verify that you are using the correct os file (0s.330, 0s.350,0s.500, or 0s.900),
and that it has world read permission.
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Chapter 7 Troubleshooting

Network computer cannot locate .thl files

Verify the primary and secondary file hosts, access methods, and paths:

If you are debugging acentralized system, or if the network computer is not
booted, check the primary and secondary file_access, file_host_name, and
file_path entriesin the xp.cnf file.

If the network computer is booted, use the Console window to see the host,
method, and path the network computer tried. Use the Left and Right mouse
buttonsto scroll through thewindow. Y ou can a so use Setup to view the host
file access information.

Verify that the appropriate daemon is running on the host for the specified
access method.

Verify that the .thl files arein the proper location and have world read
permission. If you are using secure tftp, ensure that the .thl filesarein the
secure directory. If the .thl files are not in the secure directory, either move
them to the secure directory or use NFS to download them.

Network computer cannot locate font files

» Follow the previous proceduresfor Network computer cannot locate .tbl files

to verify that the network computer is locating the fonts.thbl file.

» Verify that the fonts.tbl file specifies the correct paths to the font directories.

If NFSisused, the full pathname to the NFS mount point must be specified
if NFSis used.

» Verify that the fonts.dir and fonts.alias files exist and are readable.

» Verify that the fonts.dir and fonts.alias files contain the correct paths to the

actual font files.
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